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READ CAREFULLY BEFORE USING!
CANON SOFTWARE LICENSE AGREEMENT
IMPORTANT - READ THIS AGREEMENT BEFORE USING THE SOFTWARE ON THE
CD-ROM IN THIS BOX.  BY USING THE SOFTWARE, YOU AGREE TO BE BOUND BY THE
TERMS OF THIS AGREEMENT.

This is a license agreement (the [Agreement]) between you and Canon Inc. ([Canon]).

IF YOU DO NOT AGREE TO THE TERMS AND CONDITIONS OF THIS AGREEMENT, DO
NOT USE THE SOFTWARE PROGRAM ON THE CD-ROM AND THE USER MANUAL IN
THIS BOX (COLLECTIVELY, THE [SOFTWARE]) AND RETURN THE SOFTWARE WITHIN
30 DAYS FROM THE DATE OF PURCHASE TO YOUR POINT OF PURCHASE FOR A
REFUND.

In consideration of the right to use the SOFTWARE, you agree to abide by the terms and
conditions of this Agreement.

1.  LICENSE:  Canon grants you the non-exclusive right to use the SOFTWARE only on a
single computer.  You may physically transfer the SOFTWARE from one computer to
another provided that the SOFTWARE is used on only one computer at a time.  You shall
not install or use the SOFTWARE on a network, multiple CPU, multiple site arrangement,
or any other hardware configuration where the SOFTWARE is accessible to more than one
CPU or to more than one user.

YOU SHALL NOT ASSIGN, SUBLICENSE, RENT, LEASE, LOAN, CONVEY OR
OTHERWISE USE, TRANSFER, COPY, TRANSLATE, CONVERT TO ANOTHER
PROGRAMMING LANGUAGE, ALTER, MODIFY, DECOMPILE OR DISASSEMBLE THE
SOFTWARE, IN WHOLE OR IN PART, EXCEPT AS EXPRESSLY PROVIDED IN THIS
AGREEMENT.

2.  BACK-UP COPY:  You may make one copy of the SOFTWARE solely for back-up
purposes, or copy the SOFTWARE onto the permanent storage device (e.g. a hard disk) of
your computer and retain the original for back-up purposes.  Any other copying of the
SOFTWARE is a violation of this Agreement.  You must reproduce and include the
copyright notice on the back-up copy.

3.  SUPPORT AND UPDATES:  Canon is not responsible for providing maintenance or
support for use of the SOFTWARE.  No updates, fixes or support will be made available for
the SOFTWARE.

4.  LIMITED WARRANTY AND LIMITATION OF LIABILITY:  It is your responsibility to choose,
maintain and match the hardware and software components of your computer system.
Thus Canon does not guarantee uninterrupted service or correction of errors or that the
functions or performance of the SOFTWARE will meet your requirements.  THE
SOFTWARE IS LICENSED ON AN [AS IS] BASIS AND WITHOUT WARRANTY OF ANY
KIND. The CD-ROM storing the SOFTWARE is warranted only against defective material
under normal use for a period of ninety (90) days after purchase from an authorized Canon
dealer as evidenced by your sales receipt. Your sole remedy for a defective CD-ROM shall
be replacement of the same without charge when returned by you at your expense to your
point of purchase and proven to be defective upon inspection.  The replacement CD-ROM
will be warranted for the remainder of the original ninety (90) day warranty period of the
defective CD-ROM.  The limited warranty does not apply if the failure of the CD-ROM
resulted from accident, abuse or misapplication of the SOFTWARE and shall not extend to
anyone other than the original user of the SOFTWARE.

EXCEPT AS SPECIFICALLY SET FORTH IN THIS PARAGRAPH 4, CANON, CANON’S



In
tr

od
uc

tio
n

READ CAREFULLY BEFORE USING!

II

SUBSIDIARIES, DISTRIBUTORS AND DEALERS DISCLAIM ALL WARRANTIES, EXPRESS
OR IMPLIED, INCLUDING ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE, WITH RESPECT TO THE SOFTWARE.

NEITHER CANON NOR ANY OF CANON’S SUBSIDIARIES, DISTRIBUTORS OR DEALERS
IS LIABLE FOR ANY DAMAGES HOWSOEVER CAUSED, INCLUDING WITHOUT
LIMITATION, DIRECT, CONSEQUENTIAL OR INCIDENTAL LOSS OR DAMAGE INCLUDING
LOSS OF PROFITS, EXPENSE OR INCONVENIENCE HOWSOEVER CAUSED OR
ARISING OUT OF THE SOFTWARE OR THE USE THEREOF.

NEITHER CANON, NOR ANY OF CANON’S SUBSIDIARIES, DISTRIBUTORS OR DEALERS
SHALL HAVE ANY OBLIGATION TO INDEMNIFY YOU AGAINST ANY CLAIM OR SUIT
BROUGHT BY A THIRD PARTY ALLEGING THAT THE SOFTWARE OR THE USE THEREOF
INFRINGES ANY INTELLECTUAL PROPERTY OF SUCH THIRD PARTY.

5.  TERM:  This Agreement is effective upon your using the SOFTWARE and remains in effect
until expiration of all copyright interests in the SOFTWARE unless earlier terminated.  You
may terminate this Agreement by destroying the SOFTWARE.  This Agreement will also
terminate without notice to you if you fail to comply with any of the terms of this Agreement
and you must then promptly return the SOFTWARE.  In addition, Canon may enforce its
other legal rights.

6.  U.S. GOVERNMENT RESTRICTED RIGHTS NOTICE:  The SOFTWARE is provided with
restricted rights.  Use, duplication or disclosure is subject to restrictions as set forth in
either subparagraph (c) (1) (ii) of the Rights in Technical Data and Computer software
clause at DFARs 252.227-7013 or subparagraph (c) (1) and (2) of the Commercial
Computer Software Restricted Rights Clause at FAR 52.227-19, as applicable.

7.  SEVERABILITY:  In the event that any provision of this Agreement is declared or found to
be illegal by any court or tribunal of competent jurisdiction, such provision shall be null and
void with respect to the jurisdiction of that court or tribunal and all the remaining provisions
of this Agreement shall remain in full force and effect.

8.  CONTROLLING LAW:  The terms of this Agreement as it relates to purchases of the
Software in the United States of America shall be governed and construed in all respects in
accordance with the laws and regulations of the State of New York, without reference to
choice of law principles.  The terms of this Agreement as it relates to purchases of the
Software in Canada shall be governed by the laws of the province of Ontario.

9.  OWNERSHIP:  All rights, including but not limited to copyrights and trade secret rights, to
the SOFTWARE belong to Canon, its affiliated corporations and third party licensors.  Your
use of the SOFTWARE is subject to the United States, Canada and other applicable
copyright and trademark laws and nothing in this Agreement constitutes a waiver of the
rights of Canon, its affiliated corporations and third party licensors under such laws.
Nothing contained in Paragraph 1 shall be construed to give Canon any ownership rights in
any images, graphics or textual material that you save in connection with the Software.

10.ACKNOWLEDGEMENT:  BY USING THE SOFTWARE, YOU ACKNOWLEDGE THAT YOU
HAVE READ THIS AGREEMENT, UNDERSTOOD IT, AND AGREE TO BE BOUND BY ITS
TERMS AND CONDITIONS.  YOU ALSO AGREE THAT THIS AGREEMENT IS THE
COMPLETE AND EXCLUSIVE STATEMENT OF AGREEMENT BETWEEN YOU AND
CANON CONCERNING THE SUBJECT MATTER HEREOF AND SUPERSEDES ALL
PROPOSALS OR PRIOR AGREEMENTS, VERBAL OR WRITTEN, AND ANY OTHER
COMMUNICATIONS BETWEEN THE PARTIES RELATING TO THE SUBJECT MATTER
HEREOF.  NO AMENDMENT TO THIS AGREEMENT SHALL BE EFFECTIVE UNLESS
SIGNED BY A DULY AUTHORIZED OFFICER OF CANON.
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Safety Precautions
Please read the safety precautions carefully before using this product. Ensure that you use the
product correctly according to the procedures described in these instructions.
The following safety precautions are intended to instruct you in the safe and correct operation
of the product and its accessories to prevent injuries or damage to yourself, other persons and
property. Please read and ensure that you understand them before you proceed to the other
sections of these instructions.

Warning

Do not play the supplied CD-ROM(s) in any CD-ROM Player that does not support data
CD-ROMs. The extremely loud sound that may result from playing the CD-ROM(s) in an
audio CD player (music player) could damage the speakers. It is also possible to suffer
hearing losses from listening with headphones to the loud sounds of a data CD-ROM played
on a music CD player.

Disclaimer
• While every effort has been made to ensure that the information contained in these

instructions is accurate and complete, no liability can be accepted for any errors or omissions.
Canon reserves the right to change the specifications of the hardware and software
described herein at any time without prior notice.

• No part of these instructions may be reproduced, transmitted, transcribed, stored in a
retrieval system, or translated into any language in any form, by any means, without the
prior written permission of Canon.

• Canon makes no warranties for damages resulting from corrupted or lost data due to a
mistaken operation or malfunction of the camera, the software, the CompactFlash™ cards
(CF cards), personal computers, peripheral devices, or use of non-Canon CF cards.

Trademark Acknowledgments
• Canon and EOS are trademarks of Canon Inc.
• Adobe and Photoshop are trademarks of Adobe Systems Incorporated.
• CompactFlash is a trademark of SanDisk Corporation.
• IBM is a registered trademark of International Business Machines Corporation.
• Microsoft and Windows are registered trademarks or trademarks of Microsoft Corporation in

the United States and/or other countries.
• Macintosh is a trademark of Apple Computer Inc., registered in the United States and other

countries.
• QuickTime is a trademark of Apple Computer Inc.
• Other names and products not mentioned above may be registered trademarks or

trademarks of their respective companies.
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Conventions Used in These Instructions
● The information in these instructions is valid for the Windows 98 Second Edition (referred

to hereafter as Windows 98 SE), Windows Me, Windows 2000, and Windows XP Home
Edition/Professional (referred to hereafter as Windows XP) operating systems.

● When explanations are common to all the operating systems, the screens shown are from
Windows 98 SE.

● Descriptions of camera operations assume that the reader is familiar with the information
in the instructions supplied with the camera. For detailed information on how to use the
software products and the restrictions that apply to those products, refer also to the Help
and Readme files for the respective products.

● In order to transfer images from File Viewer Utility, you will need the retouching software.
In order to start the TWAIN Driver, you will need the TWAIN Driver-compatible application.
Explanations for transferring images from File Viewer Utility described in these
instructions and the explanations for the TWAIN Driver-compatible application all use
examples from Adobe Photoshop 5.0 LE.

: Marks information that should be read before use to prevent damage to the camera,
camera malfunction, or problems that would interfere with the functioning of software
and computer.

: Marks additional information that you will find helpful when using the camera or
software.

: These sections provide brief descriptions of the Custom Function Settings for
the respective camera functions. For more details, refer to “Custom Function
Settings” in the EOS-1Ds Instructions.

QuickTime
To save composite images made using PhotoStitch in the QuickTime VR format, you will need
QuickTime 3.0 or later. If you have not already installed QuickTime 3.0 or later on your
computer, install it using the procedure below.
1 Load the EOS DIGITAL SOLUTION DISK into the CD-ROM drive.

/ The Installer panel appears automatically.
2 Click [QuickTime 5.0 Installation].
3 Proceed with the installation as directed by the on-screen messages.

ZoomBrowser EX Software User Guide
A PDF format manual is available on the Canon website. Use your browser program to
download this manual from the web. For URL addresses*, please see the Canon Customer
Support contacts in the Canon Limited Warranty supplied with your camera.
* The PDF format manual is not available in some regions.

Adobe Acrobat Reader must be installed to read the PDF format manual.
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Software
This section briefly describes the main functions of the software provided on the bundled CD-
ROM.

■ EOS DIGITAL SOLUTION DISK
File Viewer Utility

● When you connect the camera to your computer with the interface cable, images stored on
the CF card in the camera are displayed. It also allows you to display images stored on
your card reader or computer.

● Allows you to display, save and erase images.
● Allows you to perform image processing including processing RAW images.
● Allows you to change the settings of the camera.

RemoteCapture
● RemoteCapture allows you to operate the camera remotely and download images to your

computer. RemoteCapture also lets you take pictures using a timer shooting or interval
timer shooting function, in addition to single-frame shooting.

TWAIN Driver
● This is a driver for Windows 98 SE and Windows 2000 that allows you to connect the

camera to your computer using the interface cable and display the JPEG images on the CF
card in the camera.

● It allows you to transfer the JPEG images displayed in the TWAIN Driver to a TWAIN
Driver-compatible application.
* You can start the TWAIN Driver from a TWAIN Driver-compatible application (such as Adobe

Photoshop).

WIA Driver
● This is a driver for Windows Me and Windows XP that allows you to connect the camera to

your computer using the interface cable and that automatically starts the [Scanner and
Camera Wizard] to download your images.

● It also allows you to copy camera images using standard file copying procedures in
Windows Explorer (but it cannot upload computer files to the camera).



In
tr

od
uc

tio
n

Software

VIII

ZoomBrowser EX
● When you connect the camera to your computer with the interface cable, images on the CF

card in the camera are displayed.
● This program displays downloaded images in lists and allow you to sort and organize them

by content.
● This program can start your email program* and send images as file attachments to it.

Since the file size and compression rate can be controlled, you can reduce large image files
to sizes small enough for easy transmission.
* The automatic start of email programs is supported by Windows and the email programs must be

enabled as MAPI clients.

PhotoRecord
● This program permits you to add backgrounds and borders, as well as titles and comments,

and print out the images. You can enjoy preparing prints of your images appearing as if they
were pasted into a photo album. Naturally, you can also use it to make artistic single-image
layouts.

● Allows you to make index prints using the images saved on your computer and on the
camera.

● This program can output your original photo cards or labels (8-label sheets) to Card Photo
Printer CP-10 (optional) connected to the computer by interface cable PIF-100 (optional).

PhotoStitch
● PhotoStitch provides an easy way to merge a series of overlapping images into a single,

seamless panorama by automatically arranging the frames in order. You can use this
feature to stitch your shots together into one complete 360° cylinder-shaped panorama
image.

■ Adobe Photoshop 5.0 LE DISK
Photoshop 5.0 LE

● This is a full-featured image retouching program equipped with a complete range of image
processing functions.

● You can use this program to transfer images from File Viewer Utility. You can also use this
program to start the TWAIN Driver or to download images from WIA TWAIN.
* If you already have Photoshop 5.0 LE installed on your computer, you do not need to install it again.
* Explanations for transferring images from File Viewer Utility described in these instructions and the

explanations for the TWAIN Driver-compatible application all use examples from Photoshop 5.0 LE.
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Computer

OS

CPU

RAM

Interface

Hard disk space

Display

IBM PC/AT-compatible machine equipped with an OHCI-compatible
IEEE1394 port

Windows 98 Second Edition
Windows Me
Windows 2000 Professional
Windows XP (Home Edition/Professional)
* Preinstalled versions (upgrades not supported)

Windows 98 SE
Windows Me 150 MHz Pentium or better
Windows 2000

Windows XP 300 MHz Pentium or better

Windows 98 SE
Windows Me
Windows 2000

Windows XP Minimum 256 MB required

IEEE1394

File Viewer Utility   100 MB or more
RemoteCapture     20 MB or more
TWAIN Driver     25 MB or more
WIA Driver     25 MB or more
ZoomBrowser EX   120 MB or more
(Including the PhotoRecord printing program)
PhotoStitch     40 MB or more
Adobe Photoshop 5.0 LE     40 MB or more

800 × 600 dots, 64,000 colors (16-bit color) or more required
1024 × 768 dots or more recommended

Computer System Requirements

Minimum 128 MB required

● A CD-ROM drive is required for software installation.



1
This chapter describes the procedure for installing the software for the
camera and Photoshop 5.0 LE.

Installing the Software



1-2

Installing the Software
● You must follow the procedure given below to install the software.

1.  Install the software from the EOS DIGITAL SOLUTION DISK

2.  Take the EOS DIGITAL SOLUTION DISK out of the CD-ROM drive.

3.  Install Photoshop 5.0 LE

4.  Connect the camera and complete the installation.
\ When you connect the camera to your computer, the driver is automatically installed

and driver installation ends. (On Windows 98 SE and Windows 2000, the TWAIN
Driver is installed, and on Windows Me and Windows XP, the WIA Driver is installed.)

● The driver is required for the communications between the camera and
computer.
When you use the SOLUTION DISK software to communicate between the camera
and computer, be sure to install the driver shown below appropriate to your
operating system.
• Windows 98 SE/Windows 2000: TWAIN Driver
• Windows Me/Windows XP: WIA Driver

● Do not connect the camera to your computer before you have installed the
software as this will prevent successful software installation.

Installing the Software

1 Start up your computer.
● If you are using Windows 2000 or Windows XP Professional, log on with

[Administrator] privileges.
● Close any programs that are running before you begin installing the software.

2 Load the SOLUTION DISK into the CD-ROM drive.
\ The Installer panel automatically appears.
● If the Installer panel does not appear, double-click [My Computer] on desktop (if you

are using Windows XP, click the [Start] button s [My Computer]), then right-click the
icon for the CD-ROM drive containing the SOLUTION DISK, select [Open] in the
displayed menu, and double-click the [Setup] icon.

3 Click [Software Installation].
\ The preparation of installation

starts.
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Installing the Software

4 Click the [Next] button.

5 Read all of the Software User License Agreement carefully. If you
agree to the terms of the license, click the [Yes] button.

6 Select the folder in which the software will be installed and then
click the [Next] button.

7 Select the software to be installed.
● Click the checkboxes for the

software to be installed and then
click the [Next] button.

9 Proceed with the installation as directed by the on-screen
messages.

10Restart your computer.

8 Select the EOS-1Ds.
● Click the [EOS-1DS] checkbox and

then click the [Next] button.
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Installing Photoshop 5.0 LE
● You are required to enter the serial number during Photoshop 5.0 LE installation. The serial

number is shown on the CD-ROM’s label.

1 Load the Adobe Photoshop 5.0 LE CD-ROM into the CD-ROM
drive.

2 Double-click [My Computer] on the desktop to open.
● Windows XP users should click the [Start] button and then [My Computer].

3 Double-click the [Photosle] CD-ROM icon s the [English] folder
s the [Photosle] folder.

4 Double-click the [Setup.exe] icon.

5 Proceed with the installation as directed by the on-screen
messages.
● For more information on the installation procedure, refer to the [Install] file in the

[English] folder on the Photoshop 5.0 LE CD-ROM.
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Complete the Installation of the TWAIN
and WIA Drivers

● The driver is required for the communications between the camera and
computer.
When you use the SOLUTION DISK software to communicate between the camera
and computer, be sure to install the driver shown below appropriate to your
operating system.
• Windows 98 SE/Windows 2000: TWAIN Driver
• Windows Me/Windows XP: WIA Driver

● Before you connect the camera to your computer, you must install the TWAIN
Driver or WIA Driver from the EOS DIGITAL SOLUTION DISK on your
computer. After installation is complete, take the EOS DIGITAL SOLUTION
DISK out of the CD-ROM drive.

● Set the camera’s Auto power off function to [Off] before you start installing
the driver.

● You must not set the camera’s main switch to <OFF> until installation ends.
● For the limitations of the WIA Driver, please click the [Start] button and select

[Programs] ([All Programs] on Windows XP) s [Canon Utilities] s [EOS-1DS
WIA Driver] s [WIA Driver Readme].

1 Connect the camera to your computer correctly (➞2-2).

2 Set the camera’s main switch to <ON>.
\ The driver is installed automatically and driver installation is completed.
● This automatic installation is only performed the first time you connect the camera to

your computer after installing the EOS DIGITAL SOLUTION DISK.
● If you are using Windows Me or Windows XP, the dialog box listed below appears

when installation ends. Click the [Cancel] button to close the displayed dialog box.

Windows Me: The [Scanner and Camera Wizard] dialog box appears.

Windows XP: The [EOS-1DS] dialog box appears.
● When the message appears prompting you to restart your computer, restart your

computer as directed by the message.

When the camera’s main switch to <ON>, the [Creating driver information database]
dialog box or the [Found new hardware] dialog box may appear on some computers
you use.
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Please Register Your Camera!
We recommend you take a moment to register your camera, in order to receive further product
information.
To proceed to the online User Registration page, simply click the [User Registration] button
from the [EOS DIGITAL SOLUTION DISK].
If there is no response when you click the [User Registration] button, please double-click on
the file “/SOFTWARE/INSTDATA/ENGLISH/REGIST.HTM” from Windows Explorer.

When You Have Problems with Driver Installation
If you have problems with driver installation, check the items listed below. If the [Add New
Hardware Wizard] ([Found New Hardware Wizard] in Windows 2000) dialog box appears while
you are checking these items, click the [Cancel] button and disconnect the camera from your
computer. Then re-install the driver software.

(1) Does your computer comply with these requirements?
● The system has a built-in OHCI-compatible IEEE1394 port and it comes with Windows

98 SE, Windows Me, Windows 2000 or Windows XP preinstalled. (The IEEE1394
interface is not supported for systems not complying with the above conditions.)

(2) Is the camera connected correctly?
● See “Connecting the Camera to Your Computer” (➞2-2) for more information.

(3) Are the camera and computer set up correctly for communication?
● Is the camera’s main switch set to <ON>?
● Even when the camera’s main switch is set to <ON>, operation of the Auto power off

function will automatically switch the camera off. To prevent this, set the Auto power off
to [Off]. (Refer to “Menu Settings” in the EOS-1Ds Instructions.)

(4) Is there sufficient charge left in the camera battery?
● When you connect your camera to a computer, you should use the DC Coupler Kit so

that you can continue to use your camera regardless of battery level.

If you have checked that none of the above problems apply and you still have problems with
the driver installation, refer to “Uninstalling the Driver” (➞9-7) and perform the driver
installation procedure once more from the beginning.
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This chapter explains how to connect the camera to your computer and
how to use a card reader (third-party product).

Getting Ready to Work with
Images
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Connecting the Camera to Your Computer
Connect the camera to your computer with the interface cable so that they can communicate.
You can connect the camera while your computer is running.

● When you connect the camera to your computer, be sure to follow the
procedure below.

● Never perform the following operations while the software installed from the
SOLUTION DISK runs after connecting the camera to the computer as a
communications error may occur.
• Setting the camera’s main switch to <OFF>
• Opening the CF card slot cover
• Disconnecting the interface cable, the power cord, or the AC adapter’s plug
• Removing the DC coupler or the battery

Before you perform the operations above, be sure to end the software being
used.

1 Plug the interface cable into the computer.
● Plug the cable into the IEEE1394

port on the computer.
● You can plug either end of the

cable into the IEEE1394 port.
● The location of the port differs

depending on your computer. Refer
to the User’s Manual for your
computer for details.

2 Plug the interface cable into your camera.
● Open the cover and plug the cable

into the camera’s DIGITAL terminal.
● You can plug either end of the

cable into the DIGITAL terminal.

3 Set the camera’s main switch to <ON>.
\ The camera can now communicate with your computer.
● Start up the software to be used.
\ If you are using Windows Me, the [Scanner and Camera Wizard] dialog box appears,

and if you are using Windows XP, the [EOS-1DS] dialog box appears. Click the
[Cancel] button to close these dialog boxes.

Interface cable

DIGITAL terminal

IEEE1394 port

Interface cable
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Connecting the Camera to Your Computer

● Use only the interface cable bundled with the camera to connect the camera to
your computer.

● Push the plug firmly all the way into the socket. Loose connections can cause
faults or malfunctions.

● Connect the camera to the computer directly using the interface cable. The camera
and computer may not operate correctly if you connect them via a hub or if you
connect to multiple IEEE1394 devices.

● Do not connect more than one camera to the same computer. The connections
may not operate correctly.

● While the camera and your computer are communicating, the camera’s LCD
panel may blink and, if you are using the LCD monitor, the image on the monitor
may flicker. This is not malfunction.

● If you do not perform any operation while the camera and computer are connected,
a confirmation message appears on the computer screen asking whether you wish
to continue communicating with the camera for some computer systems. If you do
not perform any operation even after this message appears, the communication
with the camera is terminated. (If you are using a household power source, no
message is displayed and the connection is not terminated.) To re-establish the
connection, press the shutter button down halfway or set the camera’s main
switch to <OFF> and then back to <ON>.

● Do not put your computer to sleep while it is connected to the camera.
If you do put your computer to sleep while it is connected to the camera, never
disconnect the interface cable while your computer is still in sleep mode. Always
wake your computer up before disconnecting the camera. On some types of
computer, disconnecting the interface cable while your computer is in sleep mode
could prevent the computer from waking up correctly. Refer to the computer
User’s Manual for more information on Sleep mode.

About Backing up (Copying) Images
● It is recommended that you should back up (copy) the captured images into the hard disk of

your computer, etc. before working with EOS DIGITAL SOLUTION DISK.

● When you connect your camera to a computer, you should use the DC Coupler Kit
so that you can continue to use your camera regardless of battery level. It is
recommended that you should set the camera’s Auto power off function to [Off].

● If your computer has a 4-pin IEEE1394 port, purchase a Canon 4-pin to 6-pin
interface cable (optional).
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Inserting a CF Card into Your Card Reader
To download images from a CF card directly onto your computer, remove the CF card from
your camera and load it into a card reader (third-party product) connected to your computer.

1 Remove the CF card from the camera.

2 Load the card into the card reader.

CF Card Folder Structure and File Names
The images on a CF card are stored in sub-folders named [XXXEOS1D], where the “XXX”
represents a number from 100 to 999, within the [DCIM] folder.

● The “****” in the file names represent the factory-set characters that are unique to each
camera.

● The “xxxx” in file names represent four-digit numbers.

****xxxx.JPG (JPEG images)

****xxxx.TIF (RAW images)

****xxxx.WAV (Sound file)

For information on connecting the card reader to your computer, refer to the User’s
Manual provided with the card reader.



3
This chapter explains how to use File Viewer Utility to display and save
images stored on a CF card loaded in the camera, and also explains how
to perform image processing including processing RAW images and how
to transfer images to the retouching software.

Working with Images in
File Viewer Utility
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1 Click the [Start] button and select [Programs] ([All Programs] on
Windows XP) s [Canon Utilities] s [File Viewer Utility xx] s [File
Viewer Utility].
● You can also start File Viewer Utility by double-clicking the [File Viewer Utility] icon on

the desktop.
● File Viewer Utility version information is displayed in xx.
\ File Viewer Utility starts, and the [Select model-specific processing mode] dialog box

appears.

2 Click the [EOS-1DS] checkbox and then click the [OK] button.
\ The File Viewer Utility main window

appears.
● The selected camera model is

added to the [Model-specific
processing mode] list box (➞3-7)
as a model-specific processing
mode to be used when you perform
processing that is unique to each
camera.

Starting File Viewer Utility

The [Select model-specific processing mode] dialog box appears only when File
Viewer Utility starts for the first time after installation. It does not appear when File
Viewer Utility starts the second time or later.

If you have not clicked the [EOS-1DS] checkbox in the procedure above, display the
[Select model-specific processing mode] dialog box from [Registered model-specific
processing mode] (➞3-39) in the [General Settings] tab sheet in the [Preferences]
dialog box, and click the [EOS-1DS] checkbox.
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Starting File Viewer Utility

Display Mode list box (➞3-8)

Menu bar
Displays the [File], [Edit], [View],
and [Help] menus. Model-specific processing mode list box (➞3-7)

Path display
Displays the connected camera,
drive on your computer and folder.

Histogram
Shows the distribution of
the brightness of an image.

Display Size list box (➞3-11)
Image transfer mode
list box (➞3-44)

Image display area

Status bar Comment input box
(➞3-15)

Image information display area
(➞3-15)

Tree View Area (➞3-5)
RGB value display
When you move the cursor over an image, the
coordinates of the cursor position and its RGB
values (8-bit conversion) are shown here.

File Viewer Utility main window

* The window above is the one on which all the information is displayed. In the actual use,
only the information needed for each circumstance is displayed.

● To close File Viewer Utility, select [Exit] from the [File] menu on the menu bar.

Show/Hide Thumbnail Frames button (➞3-11)
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Starting File Viewer Utility

Display AF Point button (➞3-10)

Save File button (➞3-34, 3-37)

Erase Image button (➞3-17)Preferences button
(➞3-39)

Camera Settings button
(➞4-2)

Refresh button (➞3-6)

IPTC information button (➞3-29) Select Image button (➞3-15)

Transfer Images button (➞3-44)

Select final image button (➞3-12)

Enter Image Number input box (➞3-12) Remove protect button (➞3-14)

Select first Image button (➞3-12) Show Help button

Select Previous Image button
(➞3-12)

About button

Select Next Image button
(➞3-12)

Play sound button (➞3-16)

Protect button (➞3-14)

Digital Exposure Compensation button (➞3-21)

Save White Balance Settings button (➞3-28)

White Balance list box
(➞3-25)

Color Matrix list box (➞3-19) Sharpening Target list box
(➞3-20)

Sharpness Level list box (➞3-20)

Color Temp. input box
(➞3-26)

Click White Balance
button (➞3-27)

Adjust Tone Curve button
(➞3-22)

* The window above is the one on which all the information is displayed. In the actual use,
only the information needed for each circumstance is displayed.

Rotate left 90 degrees button (➞3-16)

Rotate right 90 degrees button (➞3-16)
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Displaying Images
This section describes how to display images stored on a CF card in a camera or your
computer.
You can display images stored on a CF card via the interface cable while the CF card is still in
the camera. Or you can display images stored on a CF card using a third party card reader.
This section describes how to display images stored on a CF card in the camera.

Select a folder that contains images to be displayed.
● Double-click [EOS-1DS] and then

click the plus symbol [ + ] to the left
of the [DCIM] folder s the target
folder (xxxEOS1D) in [Tree View
Area].

● A number from 100 to 999 is
displayed in xxx.

● The following images can be displayed in File Viewer Utility.
• JPEG image
• RAW image shot on a Canon digital camera
• TIFF image saved in File Viewer Utility (➞3-34)

● For either displaying images stored on a CF card in a third party card reader, or
displaying images stored on your computer, follow the same procedure of clicking
the target folder to display them.

● If RAW images are included in images to be displayed, as RAW images are
processed before being displayed, there is a short delay before the images appear.

● You can copy the folder by dragging it and dropping it on another folder in [Tree
View Area]. On the menu that is displayed by right-clicking on the folder, you can
create and erase the folder, or change the folder name.

\ The image saved in the selected
folder is displayed.

The images that are processed on your computer after being shot or the images
whose file name is changed may not be displayed properly.
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Displaying Images

Updating Information on Main Window
If you take shots while the File Viewer Utility main window is displayed, the displayed image
and information may not be up-to-date. In such a case, update the displayed image and
information in the main window.

Click the [Refresh] button.
\ The information displayed in the

main window is updated.

Showing/Hiding Image Information
You can hide the histogram and image information display area to display more images in the
image display area.

Select the [View] menu s [Information Area] s [Hide].

\ The histogram and image information display area are hidden.
● If you select the [View] menu s [Information Area] s [Show], the histogram and

image information display area are displayed.
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Selecting the Model-Specific Processing Mode
You can display the RAW image process tool bar for processing RAW images.
By selecting the model of a camera on which images are shot (model-specific processing
mode) from the [Model-specific processing mode] list box, you can process the RAW images
shot on the selected camera.

Select a model-specific processing mode from the [Model-
specific processing mode] list box.

[Common Processing]
The RAW image process tool bar is erased, and you cannot change the settings of RAW
image processing.

[EOS-1DS]
The RAW image process tool bar is displayed, and when you select the RAW images shot
on the EOS-1Ds, you can process them. When a JPEG image is selected, however, the
RAW image process tool bar is grayed out and disabled.

If any images (including RAW or JPEG images) that were shot on a Canon camera
other than the EOS-1Ds are saved on the CF card in the connected camera or on the
selected folder, select [Common Processing] from the [Model-specific processing
mode] list box, or add the model-specific processing mode of the camera on which
images are shot, in the [General Settings] tab sheet (➞3-39) in the [Preferences]
dialog box.

● See “Processing RAW Images” (➞3-18) for information on how to process RAW
images.

● If you select any other camera from [Model-specific processing mode] list box, the
RAW image process tool bar for the selected camera is displayed.
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Selecting the Display Mode and Display Size

Display number
Numbers are assigned sequentially to the
displayed images starting with the first image.

Recording format
The [RAW] symbol is
displayed for RAW images.
The [RAW+JPEG] symbol is
displayed for RAW+JPEG
images. No symbol is
shown for JPEG images.

Digital exposure
compensation (➞3-21)

File name or shooting date/time
The items selected in the [Image Lower Display Item]
list box in the [General Settings] tab sheet of the
[Preferences] dialog box (➞3-39) are displayed.

Protect mark (➞3-14)
This mark is displayed for
protected images.

The available display modes are [Thumbnail display], [Preview] and [JPEG Preview]. You can
select [Large], [Middle], or [Small] as the display size for each display mode.

Selecting the Display Mode

Click the [Display Mode] list box and select the mode.
\ The images are displayed in the

selected display mode.

[Thumbnail display]
This shows multiple images arranged in
sequence. The information shown below is
also displayed for the images.

Sound recording mark (➞3-16)
This mark is displayed for images
for which sound was recorded.
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Selecting the Display Mode and Display Size

[Preview]
The selected image is displayed as a single
image.
When you select the RAW+JPEG image, the
RAW image is displayed.

[JPEG Preview]
When you select the RAW+JPEG image, the
JPEG image is displayed as a single image.
When you select the RAW image, the JPEG
image for the thumbnail display is shown.
When you select the JPEG image, it is
displayed as a single image as in the Preview
mode.

● When you start File Viewer Utility, images are always shown in the Thumbnail
display mode.

● If you double-click on the thumbnail-displayed image, it is displayed in the Preview
mode.
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Selecting the Display Mode and Display Size

Checking the AF Point
The AF point used when the shot was taken can be displayed.

1 Select [Preview] or [JPEG Preview] from the [Display Mode] list
box. (➞3-8)

2 Click the [Display AF Point] button.
\ The AF point of the camera used

when the shot was taken is
displayed.

● Click the button again to hide the
AF point.

● For images taken with One-Shot
AF, the focused AF point is
displayed. When the shot was
taken with automatic AF point
selection, multiple focused AF
points might be displayed.

● For images shot with AI Servo AF,
the selected AF point is displayed.
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Selecting the Display Mode and Display Size

Showing/Hiding the Information Display
Frame of Thumbnail Images

You can hide the information (protect mark, sound recording mark, etc.) displayed on the frame
of the thumbnail images to display more images in the image display area.

1 Select [Thumbnail display] from the [Display Mode] list box.
(➞3-8)

2 Click the [Show/Hide Thumbnail Frames] button.

\ The information display frame of the thumbnail image is hidden.
● Click the button again to display the information display frame of the thumbnail image.

See “Selecting the Display Mode” (➞3-8) for the information displayed in the thumbnail
image.

Selecting the Display Size

Click the [Display Size] list box and select the display size.
\ The image is displayed in the

selected display size.

In the Preview mode, the available image sizes are [Large] (100%), [Middle] (50%) and
[Small] (25%).
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Selecting Images
Selecting Images with the Mouse

Position the mouse cursor over the image and click on it.
● To select multiple images at

random, hold down the <Ctrl>
key and click the images.

● To select consecutive images, click
the first image and then hold down
the <Shift> key and click the last
image.

\ The frame around the selected
image changes color.

: [Select first Image] button
Selects the first thumbnail image displayed.

: [Select Previous Image] button
Selects the image before the currently selected image.

: [Enter Image Number] input box
Selects the image with the specified number. You can enter a number
between 1 and 9999. Enter the number and press the <Enter> key.

: [Select Next Image] button
Selects the next image.

: [Select final image] button
Selects the last thumbnail image displayed.

To select an image using the keyboard, use the arrow keys (↑ ← → ↓) to move to the
image.

Selecting Images from the Control Panel

Use the button or input a value.
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Working with Selected Images
Operations that Can Be Used with Images

The table below lists the operations available with File Viewer Utility. When a JPEG image is
selected, the unavailable operations are shown grayed out. When operations such as [Rotate
Image] are specified for a RAW image recorded in the RAW+JPEG formats, the operations are
also applied to the JPEG image recorded at the same time. However parameters that can only
be used with RAW images, such as [Color Matrix], are not applied.

Image recording formats and image processing options

You can make the neutralizing false color settings and the neutralizing false resolution
settings of RAW images in the [RAW Image Processing settings] tab sheet (➞3-40) in
the [Preferences] dialog box.

Operations

Protect

Erase

Display AF Point

Play Sound

Comment Input

Transfer Image

Save File

Rotate Image

Color Matrix

Sharpness

Digital Exposure
Compensation

Adjust Tone Curve

White Balance

Click White Balance

IPTC Information

RAW

✓

✓

✓

✓

✓

✓

✓

✓

✓

✓

✓

✓

✓

✓

✓

JPEG

✓

✓

✓

✓

✓

✓

✓

✓

–

–

–

–

–

–

–

Description

Protects the image so it cannot be erased.

Erases unprotected images.

Displays the focused or the used AF point.

Plays the sound recorded by the camera.

Attaches a brief comment to each image.

Transfers images to the retouching
software.

Saves an image to your computer, etc.

Rotates the image by 90-degree unit.

Sets film-equivalent characteristics or color
range characteristics.

Adjusts the level or target frequency pattern
of sharpness.

Adjusts the brightness.

Adjusts the brightness and color saturation.

Adjusts the white balance.

Automatically adjusts the white balance.

Sets the IPTC information details.
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Working with Selected Images

Protecting Images
You can protect important images to prevent them from being accidentally erased.

Click the [Protect] button.

● When multiple images are selected, all the selected images are protected.
● The [       ] is automatically displayed for images that were protected on the camera.
● Protection only prevents images from being erased. Other types of image

processing can still be performed for protected images.
● A range of operations is also available by selecting the image, pressing the right

mouse button and selecting an option from the menu that appears.

\ The image is protected, and the [       ] is displayed.
● Clicking the [Remove protect]

button clears the [       ] and
removes the protection.
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Working with Selected Images

Selecting Images by Condition
This feature allows you to select multiple images in a single operation using conditions, such
as selecting all displayed images, or protected images only or unprotected images only.

Click the [Select Image] button and select the condition from the
menu that appears.
\ Only images that meet the

condition are selected.

Comment input box
You can use this box to type in a comment up to 120 characters long.
Type in your comment and press the <Enter> key.

Image information display area
● Displays information such as the file name, camera model name and shooting

data. The number of items displayed differs depending on the camera settings.
● Use the scroll buttons to display parts of the information that are not visible.
● When you select multiple images, the information from the image selected last is

displayed.
● You can copy the information as text data and paste it into another application.

Checking the Image Information
Shooting information is recorded when images are taken. You can check the shooting
information by selecting the image. Also, you can copy shooting information to paste it into
another application, and you can add a comment.

When the shot was taken using Color Matrix 4
Images shot with color matrix 4 must be transferred to the retouching software (third-
party product) (➞3-44) so that settings such as the chroma can be adjusted. The color
matrix information is shown in the Image information display area.
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Working with Selected Images

Rotating Images
Use the procedure below to rotate a selected image by 90-degree unit left or right.

Rotate the image.
● To rotate the image right

(clockwise), click the [Rotate right
90 degrees] button.

● To rotate the image left
(counterclockwise), click the
[Rotate left 90 degrees] button.

\ The image rotates 90 degrees in
the selected direction.

● When multiple images are selected, all the selected images are rotated.
● A range of operations is also available by selecting the image, pressing the right

mouse button and selecting an option from the menu that appears.

Playing Back Sound
Use the procedure below to play back sound that was recorded with an image.
The sound recording mark is displayed for images for which sound was recorded.

1 Select an image with [     ] displayed, and click the [Play sound]
button.
\ The [Audio Note] dialog box

appears.

2 Adjust the sound with the buttons and Slider.

: [Play] button
Plays back the recorded
sound.

: [Pause] button
Pauses sound playback. Click
the [Play] button to resume.

: [Stop] button
Stops sound playback.

: Slider
Indicates the sound playback
position.

● Clicking the [Close] button closes the [Audio Note] dialog box.
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Working with Selected Images

Erasing Images
Use the procedure below to erase unwanted images from a CF card or your computer.

1 Click the [Erase Image] button.
\ The [Canon Digital Camera] dialog

box appears.

2 Click the [OK] button.
\ The image is erased.

● Erased images cannot be restored. Check carefully before erasing images.
● Protect important images to prevent them from being accidentally erased.
● When multiple images are selected, all the selected images are to be erased. Take

particular care when you have just finished a task involving the selection of multiple
images.

● When you erase the RAW+JPEG image, the JPEG image is also erased.
● When you erase an image with [       ] displayed, the recorded sound is also erased.

A range of operations is also available by selecting the image, pressing the right
mouse button and selecting an option from the menu that appears.

Printing Images
You can print images in index format.

1 Select images to be printed in index format (➞3-12).
● Select multiple images to be printed in index format.

2 Select [Print Index] in the [File] menu.
\ The images are printed.

If you wish to specify the printer settings, select [Paper Set] from the [File] menu.
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Processing RAW Images
RAW images are processed so that they are optimized for their intended purpose. As well as
providing the same color matrix and white balance settings, etc. as the camera, File Viewer
Utility allows you to specify digital exposure compensation, tone curve adjustment and white
balance adjustment using click white balance as additional processing parameters.
This processing does not involve working with the original RAW images. It applies virtual
parameters to RAW images temporarily downloaded to the computer. Accordingly, you can
redo the processing repeatedly with different parameters.
You can also change the modified parameters back to the settings used when the shot was
taken.

1 Process the RAW image.
● Select [EOS-1DS] from the [Model-specific processing mode] list box. (➞3-7)
● Select the RAW image to be processed. (➞3-12)
● It is recommended that you use the Preview mode to check the processed image.

(➞3-9)

2 Change the parameter settings.
● Change parameter settings. See the pages that follow for information on how to set

the parameters.
\ The image is reprocessed using the modified parameters and the result is shown.
● Because the parameters set during shooting and the modified parameters for the

original RAW image are updated in realtime.

3 Save or transfer the image in a commonly used format.
● You can save an image as a JPEG or TIFF format by clicking the [Save File] button

and selecting [Convert and save in file] from the menu that appears (➞3-34). If you
select [Save Index], multiple images can be saved as an index. (➞3-37)

● Clicking the [Transfer Images] button transfers the image to the retouching software
that you have set. (➞3-44) You can specify the number of bits for colors when the
image is transferred in the [RAW Image Processing settings] tab sheet in the
[Preferences] dialog box (➞3-40).

When multiple images are selected, the specified processing is applied to all the RAW
images selected.
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Processing RAW Images

Selecting the Color Matrix
Use the procedure below to select the film-equivalent hue, chroma and color range (the range
of colors that can be reproduced).

Select the color matrix from the [Color Matrix] list box.
\ The resulting image appears in

Preview mode.

● It is recommended that you should use the retouching software (third-party product)
that supports 16-bit images for the one to be set for the transfer image function of
File Viewer Utility.

● When you intend to transfer an image shot using Color Matrix 4 to the retouching
software (third-party product), it is recommended that you should set the
[Transferring images to application] option in the [RAW Image Processing settings]
tab sheet in the [Preferences] dialog box (➞3-40) to [16 bits per color channel] so
that the transferred image is suitable for image processing.

Color Matrix

Shot Settings

Color Matrix 1

Color Matrix 2

Color Matrix 3

Color Matrix 4

Color Matrix 5

Settings

Select this option to apply the color matrix used when the shot was
taken.

Reproduces the hues and chroma for natural color tones.
Select this option to show the subject’s natural color tones.

Reproduces hues and chroma suited to portraits.
Select this option to reproduce beautifully natural skin tones.

Reproduces hues and chroma similar to those in high-chroma color
slide film. Select this option to reproduce clear and vivid color tones.

Processes images so that the color space is compatible with Adobe
RGB. Select this option when you intend to convert the image profile to
Adobe RGB or you want to make fine adjustments to the chroma.
If you intend to convert the image profile, transfer the image to a
software application with a conversion function and specify Adobe RGB
(this option does not append an ICC profile to the image). In sRGB
environments, because the color chroma of the image is low, you
should transfer the image to the retouching software that you have set
(third-party product) and adjust the chroma.

Processed as low-chroma image. Effective for making color tone
moderate.
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Processing RAW Images

Adjusting the Sharpness
You can adjust the sharpness of the image edge.

Adjusting the Sharpness Level

Select the desired level from the [Sharpness Level] list box.
● Higher values give higher levels of

edge sharpening.
\ The selected level is applied in the

image.

Adjusting the Pattern Sharpness

Select the desired target frequency pattern from the [Sharpening
Target] list box.
\ The selected target frequency

pattern is applied in the image.
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Processing RAW Images

Correcting the Brightness (Digital Exposure Compensation)
You can correct the brightness of an image in the range of +/–2 stops in 0.1-stop increments.

1 Click the [Digital Exposure Compensation] button.
\ The [Digital Exposure

Compensation] dialog box appears.

2 Correct the image brightness.
● When you drag the slider left or

right with the mouse, the image
brightness can be adjusted.

● The [Preview] button appears in
the Preview mode. When you click
the [Preview] button, the image
brightness changes according to
the value of the new slider position.

3 Click the [OK] button.
\ The corrected value is applied to

the image and the [Digital
Exposure Compensation] dialog
box closes.

\ The corrected value is displayed
with the corrected image.

The [Digital Exposure Compensation] dialog box
in the Preview mode

The [Digital Exposure Compensation] dialog box
in the Thumbnail display mode
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Processing RAW Images

Tone Curve

Output box

Save buttonRead button

Preview button

Apply button Cancel button

Shot Settings button

Input box

Tone curve settings list box

Adjusting the Color and Brightness (Adjust Tone Curve)
You can use the tone curve to adjust the colors and brightness.
You can also save and load the adjusted tone curve on your computer as tone curve data.
In addition, you can register the tone curve data saved on your computer as parameters in the
camera. (➞4-24)

1 Click the [Adjust Tone Curve] button.
\ The [Adjust Tone Curve] dialog box

appears.

2 From the [Tone curve settings] list box, select the channel you
want to use.
RGB: The same settings are used for

all RGB channels.
Rch: The settings are used for the

red channel.
Gch: The settings are used for the

green channel.
Bch: The settings are used for the

blue channel.
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Processing RAW Images

3 Adjust the tone curve.
● Position the mouse cursor over one

of the 4 points <    > on the tone
curve, and drag the point to the
desired location to adjust the tone
curve.
Horizontal axis: Input level
Vertical axis: Output level

● Adjusted points are shown with
< ■ >.

● You can also set the points being
adjusted by entering values directly
into the [Input] and [Output] boxes.

● When the [Linear] checkbox is clicked in the [RAW Image Processing settings] tab
sheet in the [Preferences] dialog box, tone curve adjustment cannot be performed.
(➞3-40)

● Once you have adjusted the tone curve for channel G, you can then apply the
settings of channel G to all the channels by selecting [RGB] in the [Tone curve
settings] list box.

● Windows/Macintosh compatibility for tone curve data
Tone curve data saved on your computer is compatible between Windows and
Macintosh.

4 Press the [Preview] button.
\ The adjusted image is shown in the Preview window.

5 Check the settings on the image.
● Check the adjusted image shown in the Preview window and repeat steps 3 and 4 to

make further adjustments.
● Clicking the [Shot Settings] button restores the settings to the values used when the

shot was taken.
● Clicking the [Save] button saves the adjusted tone curve on your computer. Select

the destination folder and then save the tone curve data. You can then register the
saved tone curve on the camera using parameter setting. (➞4-24)

● You can load the tone curve data saved on your computer by clicking the [Read]
button.

6 Click the [Apply] button.
● This applies the adjusted tone curve to the image and closes the [Adjust Tone Curve]

dialog box to end the procedure.
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Tone Curve
A tone curve shows the brightness and color saturation for the original image (input) and the
adjusted image (output) in the form of a line graph. You can use the tone curve to adjust the
image brightness and color saturation values that were set by the camera when the shot was
taken. Also, by using the tone curve to adjust an image, you can tailor the image to the
particular color reproduction characteristics of your monitor or printer so that you obtain the
most faithful color reproduction.
The tone curve adjustment options include [RGB], which adjusts the input and output for the
entire image in a single operation, as well as the [Rch], [Gch] and [Bch] settings that adjust
each color individually. You can use the [Tone curve settings] list box to switch between the
different channels as you make your adjustments.
The horizontal axis shows the brightness and color saturation for the unadjusted (input) image,
with the left-hand end indicating shadow (darker areas of the image) and the right-hand end
indicating highlights (brighter areas of the image).
The vertical axis shows the brightness and color saturation for the adjusted (output) image,
with the lower end indicating shadow and the upper end indicating highlights.
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Processing RAW Images

Adjusting the White Balance
You can adjust the white balance in your RAW images.
You can also save the adjusted white balance on your computer as white balance data.
(➞3-28) In addition, you can register the white balance data saved on your computer as
personal white balance data in the camera. (➞4-29)

Select the White Balance

Select the white balance from the [White Balance] list box.
● The table below shows the 9

available white balance settings.

\ The adjusted image appears.

White Balance

Shot Settings

Auto

Daylight

Shade

Cloudy

Tungsten

Fluorescent

Flash

color temp

Details

Select this option to apply the white balance
setting used when the shot was taken.

File Viewer Utility automatically adjusts the white
balance.

Select this setting for shots taken outdoors in
sunny weather.

Select this setting for shots taken outdoors in
shade.

Select this setting for shots taken outdoors in
cloudy weather or in shade, at dusk and for shots
of sunsets.

Select this setting for shots taken in incandescent
lighting.

Select this setting for shots taken in fluorescent
white lighting.

Select this setting for shots taken using a flash.

Select this option to directly set a value between
2800K and 10000K (in 100K increments) as the
white balance color temperature. (➞3-26)

Color temp./K (Kelvin)

–

Approx. 3000 to 7000

Approx. 5200

Approx. 7000

Approx. 6000

Approx. 3200

Approx. 4000

Approx. 6000

Approx. 2800 to 10000
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Setting the Color Temperature
You can set the white balance color temperature to a value between 2800K and 10000K (in
100K increments).

1 Select [color temp] from the [White Balance] list box.

2 Enter a color temperature.
● Enter the color temperature in the

[Color Temp.] input box.
● You can enter values between

2800K and 10000K (in 100K
increments).

3 Press the <Enter> key.
\ The adjusted image appears.
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Processing RAW Images

Click White Balance Function
This function allows you to automatically adjust the white balance simply by clicking a point in
a white part of the image.

1 Click the [Click White Balance] button.
\ When you move the cursor over

the image, it changes to the shape
of a filler.

2 Click in a white area in the image.

\ The white balance is adjusted so that the area clicked appears white and the result in
displayed.

● To adjust the white balance using a different location, click the [Click White Balance]
button again.

When you use Click White Balance Function, [White Point] is displayed in the [White
Balance] list box.
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Saving the White Balance
You can save the adjusted white balance settings on your computer as white balance data.
You can then register the saved white balance data on your camera as personal white balance
settings. (➞4-29)

1 Click the [Save White Balance Settings] button.
\ The [Save As] dialog box appears.

2 Enter the settings a name and click the [Save] button.
\ Select the destination folder and

then save the white balance data.
● You can also register the saved

white balance data as a personal
white balance on the camera.
(➞4-29)

Windows/Macintosh compatibility for white balance data
White balance data saved on your computer is compatible between Windows and
Macintosh.
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Setting the IPTC Information
IPTC stands for International Press Telecommunications Council and refers to a standard for
communications and information exchange tags attached to images. The standard was
established by newspaper and communications companies to allow problem-free transmission
of images.
The IPTC tags can be attached to the RAW images taken with the camera. The owner’s name
and the date/time data is automatically included in the IPTC information as part of the data
specified in the camera setup functions settings in the [Basic Settings] tab sheet in the
[Camera Settings] dialog box. (➞4-3) The specified IPTC information can also be saved or
read on your computer.

1 Select a RAW image for which the IPTC information is set. (➞3-12)

2 Click the [IPTC information] button.
\ The [IPTC information] dialog box

appears.

3 Select an item and specify the information.
● Click the desired IPTC information tab to display the tab sheet.
● Enter the information and press the <Enter> key.
● If multiple images are selected, use the [<Previous] and [Next>] buttons to switch

between images.
● After using the [<Previous] and [Next>] buttons to switch between images, you can

copy the IPTC information entered for the previous image by clicking the [Go Back]
button.

● Click the [Clear] button to clear all the settings.

4 Click the [Save] button.
\ The specified IPTC information is applied to the image.
● Clicking the [Save As] button saves the specified IPTC information on your computer.
● Click the [Read] button to read the IPTC information saved on your computer.

5 Click the [OK] button.
\ The specified IPTC information is applied to the image, the [IPTC information] dialog

box closes and the procedure ends.
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● The settings you can specify in the [IPTC-1] tab sheet are described below.
1 Enter an image title. You can enter up to 64 characters.
2 Enter the location from which the image is sent. You can enter up to 32 characters.
3 Type in a number or code designated by the company sending the image. You can enter

up to 32 characters.
4 Type in a description of the photographed image. You can enter up to 2000 characters.
5 Type in the name of the person who wrote the caption. You can enter up to 32 characters.
6 Type in the photographer’s name. You can enter up to 32 characters.

When the name of the camera owner is specified (➞4-4), this name is entered
automatically.

7 Type in the photographer’s title. You can enter up to 32 characters.

1

2

3

4

5

6

7

[IPTC-1] tab [IPTC-2] tab [IPTC-3] tab
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Setting the IPTC Information

● The settings you can specify in the [IPTC-2] tab sheet are described below.
8 Enter a service ID up to 10 characters long.
9 Select the appropriate priority level from the list box. (1: Highest Priority,

5: Normal, or 8: Low Priority)

10 Type in any instructions required for editing. You can enter up to 256 characters.
11 The date on which the image was photographed is automatically entered.
12 The time at which the image was photographed is automatically entered.
13 Enter the name of the device used to create the image data. You can enter up to 32

characters.

8

9

10

11

12

13
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● The settings you can specify in the [IPTC-3] tab sheet are described below.
14 Enter the image type. Image types can be designated for each company. You can enter up

to 3 characters.
15 Enter additional category details. You can enter up to 32 characters.
16 Enter a search keyword for each company. You can enter up to 32 characters.
17 Enter the image subtitle. You can enter up to 256 characters.
18 Enter the credits for a photographed image. You can enter up to 32 characters.
19 Enter the original owner of the image. You can enter up to 32 characters.

When the name of the camera owner is specified (➞4-4), this name is entered
automatically.

14

15

16

17

18

19

20

21

22

24

25

27

28

29

23

26
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Setting the IPTC Information

● The buttons listed below are displayed in each of the tab sheets. They
function in the same way in each sheet.

20 Reads IPTC information settings saved on your computer.
21 Saves the current IPTC information settings on your computer.

Select the IPTC information destination folder and then save the IPTC information.
22 Clears the IPTC information. This button also clears the information in the tab sheets not

currently shown.
23 Displays the image thumbnails.
24 When multiple images are selected, this button displays the IPTC information for the

previous image.
25 When multiple images are selected, this button displays the IPTC information for the next

image.
26 Shows the sequential position of the displayed image and the total number of frames.
27 Copies the IPTC information values entered before the [<Previous] or [Next>] button was

clicked.
28 Applies the specified IPTC information to the image.
29 Applies the specified IPTC information to the image, closes the [IPTC information] dialog

box and ends the procedure.

Windows/Macintosh compatibility for IPTC settings data
IPTC settings data saved on your computer is compatible between Windows and
Macintosh.
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Saving Images
This section explains how to save images stored on a CF card in the camera via the interface
cable onto your computer and how to save multiple images as an index file on your computer.

Saving Images from the Camera to Your Computer
You should save the images you have shot on your computer.

1 Select images to be saved. (➞3-12)

2 Click the [Save File] button and select [Convert and save in file]
from the menu that appears.
\ The [Save File] dialog box appears.

4 Select a folder.
● Select the folder that the images

will be saved in from the folder
display area and click the [OK]
button.

\ The image files in the selected
folder are displayed in the file
display area.

File display areaFolder display area

New folder button

3 Click the [Browse] button.
\ The [Save Folder Specification]

dialog box appears.

Save Folder Specification dialog box
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Saving Images

1

8

7

2

10

9

43

5 Set the save options and click the [OK] button.
\ The images are saved in the selected folder.

1 The converted image is saved in the same folder as the displayed image. You cannot
select this option for images that are saved on a CF card in the camera. This option is only
available for images saved on your computer or on a CF card in a card reader.

2 Use this button when you want to specify the folder in which the image will be saved.
3 When the [Save in following specified folder] radio button is selected, this button specifies

the folder in which the image will be saved.
4 Shows the folder in which the image will be saved.

\ Clicking the [New folder] button
opens the [New folder] dialog box.

● You can create a new folder inside
the selected folder by entering the
folder name and clicking the [OK]
button.

11

12

6

Save File dialog box

5
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5 Select this option when the images to be saved include RAW images.
Select [Do not convert], [Exif-JPEG], [Exif-TIFF(8bit/ch)] or [TIFF(16bit/ch)].
The file extensions used for the saved files are shown below.

Conversion Format

Do not convert

Exif-JPEG

Exif-TIFF(8bit/ch)

TIFF(16bit/ch)

File Extension

_.TIF

_RJ.JPG

_RT8.TIF

_RT16.TIF

To use linear processing, specify linear processing in the [Preferences] dialog box
(➞3-40) and select [TIFF(16bit/ch)] when you save the image. Even when linear
processing is specified, linear processing cannot be applied to images saved in [Exif-
TIFF(8bit/ch)] format.

6 You can specify the [Compression Ratio] (image quality) when you select [Exif-JPEG] from
the [Convert from RAW to Other Format] list box. You can select from 4 compression
ratios-[4 (Highest Image Quality)] to [1 (High Compression Ratio)]. The higher the value,
the higher the quality of the JPEG image.

7 Click this checkbox when you want to save the image without changing the name.
8 This is text inserted before the file number for sorting. You can enter up to 12 characters.

When you enter text, an example of the file name appears in the [Example] field below the
text box.

9 You can specify up to 9 digits in the file number.
10 Specifies the first file number.
11 You can select this option when the images to be saved include images that were

recorded simultaneously in RAW+JPEG formats. You can choose to save the images in
[Both] RAW and JPEG formats, in [RAW Only] or in [JPEG Only].

12 When the image files to be saved include images with sound, this option can save the
sound files with the respective images.

A range of operations is also available by selecting the image, pressing the right
mouse button and selecting an option from the menu that appears.
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Saving Images

Saving Images as Index File
You can save multiple images as an index file on your computer.

1 Select images to be saved as an index. (➞3-12)

2 Click the [Save File] button and select [Save Index] from the
menu that appears.
\ The [Index Sheet Options] dialog

box appears.

3 Enter the settings and click the [OK] button.

Index Sheet Options dialog box

1 Enter the width of the index sheet to be created.
2 Enter the height of the index sheet to be created.
3 Enter the resolution of the index images.
4 Indicates the projected image file size based on the specified width, height and resolution.
5 The settings are applied and the [Index Sheet Options] dialog box closes.
6 Cancels the index sheet options settings.

\ The [Save index file] dialog box appears.

1

2

3

4

5 6
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4 Specify the save options and click the [OK] button.
\ The images are saved as the index in the selected folder.

Save index file dialog box

1 The converted image is saved in the same folder as the displayed image. You cannot
select this option for images that are saved on a CF card in the camera. This option is only
available for images saved on your computer or on a CF card in a card reader.

2 Use this button when you want to specify the folder in which the image will be saved.
3 When the [Save in following specified folder] radio button is selected, this button specifies

the folder in which the image will be saved.
4 Shows the folder in which the image will be saved.
5 This is text inserted before the file number for sorting. You can enter up to 12 characters.

When you enter text, an example of the file name appears in the [Example] field below the
text box.

6 You can specify up to 9 digits in the file number.
7 Specifies the first file number.

1
2

3 4

65 7

A range of operations is also available by selecting the image, pressing the right
mouse button and selecting an option from the menu that appears.
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● You can specify the settings shown below in the [General Settings] tab sheet.

1 When you click the [Transfer Images] button (➞3-4, 3-44), the retouching software (third-
party product) to which the image will be transferred is specified. (➞3-42)

2 Specify the folder for saving the image to be transferred to the retouching software. (➞3-42)
3 Specify the information to be displayed below images. Select [File Name] or [Shooting

Date/Time] in the list box.
4 You can add or erase model-specific processing modes to be displayed in the [Model-

specific processing mode] list box (➞3-3, 3-7). You can add the model-specific processing
mode if you click the checkbox of the camera to be added and click the [OK] button on the
[Select model-specific processing mode] dialog box displayed by clicking the [Select] button.
If you clear the checkbox, the model-specific processing mode is erased.

Specifying the Preferences
You can use the procedure below to specify the general settings for File Viewer Utility and the
processing method for RAW images.

1 Click the [Preferences] button.
\ The [Preferences] dialog box

appears.

1

2

3

4

2 Select the [General Settings] tab or the [RAW Image Processing
settings] tab.
\ The selected tab sheet appears.

3 Specify the desired settings and then click the [OK] button.
\ The settings are applied and the [Preferences] dialog box closes to end the

procedure.

General Settings tab sheet
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RAW Image Processing settings tab sheet

5

8

9

6
7

11 12 13

10

● You can specify the settings shown below in the [RAW Image Processing
settings] tab sheet.

The settings described here are those shown when [EOS-1DS] is selected in the [Model
Name] list box.

5 Select [EOS-1DS].
* The camera models selected in [Registered model-specific processing mode] in the

[General Settings] tab sheet are displayed in the model name list.
6 You should select this option when you want to perform the linear processing on an image.

If you select this option, the tone curve adjustment (➞3-22) cannot be performed.
Since the linear processing is performed on the tone curve adjustment, there is little image
degradation as a result and you can make your own fine adjustments to the chroma in the
retouching software.

7 Clicking this checkbox neutralizes false colors.
8 Clicking this checkbox neutralizes false resolution.
9 Select [8 bits per color channel] or [16 bits per color channel] as the bit rate.
10 Clicking this checkbox ensures that both the RAW and JPEG images are transferred when

you transfer an image in the RAW+JPEG format. If you clear this checkbox, only the RAW
image is transferred.

When you select any other camera in the [Model Name] list box, the available settings
for the respective camera model are displayed.
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Specifying the Preferences

● The buttons listed below are displayed in each of the tab sheets. They
function in the same way in each sheet.

11 Restores the default settings for all the parameters in the currently displayed tab sheet.
12 Applies the specified parameters, closes the [Preferences] dialog box and ends the

procedure.
13 Discards all the settings, restores the parameters to their original values and ends the

procedure.
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Transferring Images to Retouching Software
This section describes how to transfer images displayed in File Viewer Utility to the retouching
software and also describes how to make settings for image transfer.

● In order to transfer images, you will need the retouching software such as
Adobe Photoshop.

● Be sure to make the image transfer settings before transferring images.

Specifying the Image Transfer
Before transferring images, it is necessary to specify the retouching software to which images
will be transferred and the folder for saving the images to be transferred. The descriptions
given here show how to transfer images to the bundled application, Adobe Photoshop 5.0 LE,
as an example.

1 Display the [General Settings] tab sheet in the [Preferences]
dialog box. (➞3-39)

2 Click the [Browse] button of [Image Transfer Application].
\ The [Open] dialog box appears.

3 Select [photosle] and then click the [Open] button.

\ Photoshop 5.0 LE is specified as the retouching software to which images will be
transferred and then the [General Settings] tab sheet appears.
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Transferring Images to Retouching Software

4 Click the [Browse] button of [Image transfer folder].
\ The [Select Folder] dialog box appears.

5 Select the folder for saving the transferred images and then click
the [OK] button.

\ The folder is specified and then the [General Settings] tab sheet appears.

6 Click the [OK] button.
\ The settings are applied, the

[Preferences] dialog box closes,
and the procedure ends.

It is not necessary to specify the retouching software to which the images will be
transferred and the folder for saving the transferred image every time unless you wish
to change those settings.
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Transferring Images
This section describes how to transfer the images displayed in File Viewer Utility to the
retouching software. Although the descriptions given here show how to transfer images to the
bundled application, Adobe Photoshop 5.0 LE, as an example, you can also transfer images
by following the same procedure even if you specify any other retouching software in
“Specifying the Image Transfer” (➞3-42).

1 Select images to be transferred. (➞3-12)

2 Select the transfer mode from the [Image transfer mode] list box.
● There are 2 available transfer

modes.
[Single-Frame Transfer]:
The selected images are
transferred as an individual image.
[Transfer as Index Image]:
Thumbnails are created for the
selected images and transferred as
an index sheet.

3 Click the [Transfer Images] button.
\ If you selected [Transfer as Index

Image], the [Index Sheet Options]
dialog box appears.

\ If you selected [Single-Frame
Transfer], the image will be
transferred.

● For information on how to make
settings in the [Index Sheet
Options] dialog box, refer to step 3
in “Saving Images as Index File”
(➞3-37).
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Transferring Images to Retouching Software

● Display images transferred with
[Transfer as Index Image].

4 Enter the settings and click the [OK] button.
\ Photoshop 5.0 LE starts and the image is transferred.
\ The transferred image is saved in the image transfer folder that you have set.
● Display an image transferred with

[Single-Frame Transfer].

A range of operations is also available by selecting the image, pressing the right
mouse button and selecting an option from the menu that appears.
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4
This chapter describes basic settings such as Owner’s Name and Date/
Time, as well as detailed settings such as the Personal Functions,
Parameters and Personal White Balance.

Specifying Camera Settings
from Your Computer
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Specifying the Camera Settings
In the Camera Settings dialog box, you can specify Basic Settings such as Owner’s Name,
and Date and Time, and you can also use the Personal Functions and Parameters to specify
Detailed Settings of the camera functions.

Basic Settings
Use the procedure described here to apply the owner name and date/time settings to the
camera. The owner name, and date and time that were applied on the camera are recorded
with the photographed images and also used as IPTC information (➞3-29).
You can also format (initialize) CF cards and check the camera properties data and the status
of the battery and the CF card.

Display the [Camera Settings] dialog box.
● To display this dialog box from File

Viewer Utility, click the [Camera
Settings] button in the main
window.

● To display this dialog box from the
WIA Driver, select [EOS-1DS] in
Windows Explorer, and then select
[Properties] from the [File] menu.

\ The [EOS-1DS Properties] dialog
box appears.

● Select the [Camera Settings] tab,
and then click the [Camera
Settings] button.

● To display this dialog box from
ZoomBrowser EX, click the [Set]
button in the Camera window and
select [Camera Settings] from the
menu that appears. See Chapter 8
“Working with Images in
ZoomBrowser EX” for information
on how to display the Camera
window.

● To display this dialog box from
RemoteCapture, select [Camera
Settings] from the [Camera] menu
in the Shooting window.

\ The [Basic Settings] tab sheet in the [Camera Settings] dialog box appears.
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Specifying the Camera Settings

This box shows the
Camera’s model name,
Body ID and Firmware
Version.

These fields set the
camera owner and the
date and time. You can
enter up to 31 characters
in [Owner’s Name].

The battery level of the
camera battery is indicated
by [           ] or [           ]. When
a household power source is
used, [     ] is displayed.

This box shows whether
a CF card is loaded in
the camera along with
the available space on
the card and its total
capacity. You can also
format a CF card from
this box.

Applies the specified
settings, closes the [Camera
Settings] dialog box and
ends the procedure.

Discards all the settings, restores
the parameters to their original
values and ends the procedure.

Applies the settings.

Formatting (initializing) a CF card erases all the data on the card. Because formatting
also erases protected images, you should check the data recorded on the card
carefully before proceeding.

Basic Settings tab sheet

Opens the help window of the
[Camera Settings] dialog box.
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Setting the Owner’s Name, Date and Time

1 Enter the Owner’s Name.
● Type in the name from your keyboard. You can enter up to 31 characters.

2 Set the Date and Time.
● You can click Date or Time with the mouse and use the [▲] and [▼] buttons to set the

Date and Time, or you can enter the desired date or time from the keyboard. Clicking
the [From PC] button imports the Date and Time data from your computer.

3 Click the [Apply] button.
\ The owner’s name, date and time settings are applied to the camera.
● Once you click the [Apply] button, the settings remain effective until you reset the

owner’s name, date or time.
● Clicking the [OK] button applies the specified settings, closes the [Camera Settings]

dialog box and ends the procedure.
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Specifying the Camera Settings

Detailed Settings
The Detailed Settings consist of the Personal Functions, parameter settings and personal
white balance settings, and allow you to apply and store highly detailed settings on the
camera. You can also save and load the settings for each function on your computer.

1 Click the [Detailed Settings] tab.
\ The [Detailed Settings] tab sheet appears.

2 Click the desired settings button.

Sets the processing
parameters and stores the
parameter settings on the
camera. “Setting the
Parameters” (➞4-24)

Sets up to 25 Personal
Functions and applies the
settings to the camera.
“Personal Function Settings”
(➞4-6)

Registers the white balance
data saved on your
computer on the camera.
“Selecting the Personal
White Balance” (➞4-29)

Detailed Settings tab sheet
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Personal Function Settings
For the EOS-1Ds, you can set up to 25 Personal Functions tailored to different types of
photography and apply those function settings to the camera. The 25 Personal Functions are
divided into the [Exposure Functions], [AF Functions], [Drive Functions] and [Other Functions]
categories, each with their own tab sheets. There is also a [Combination] tab sheet, in which
you can check the Personal Functions that are currently set up. In the [Combination] tab sheet
you can also save and load the Personal Function settings on your computer.

Setting Up Personal Functions

1 Click the [Personal Functions] button.
\ The [Personal Function Settings] dialog box appears.

2 Select the desired settings tab.

\ The display switches to the selected tab sheet.
● Clicking the [t ] / [ s] buttons can display other tabs.
● By selecting the [Combination] tab, you can check and save or load the Personal

Functions that have been set up.
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Personal Function Settings

P.Fn-01
P.Fn-02

P.Fn-03
P.Fn-04
P.Fn-05

P.Fn-06
P.Fn-07

P.Fn-08
P.Fn-09
P.Fn-10

P.Fn-14
P.Fn-15

P.Fn-16

P.Fn-17
P.Fn-18

P.Fn-19
P.Fn-20

P.Fn-21

P.Fn-23
P.Fn-24

P.Fn-25

P.Fn-27
P.Fn-28

P.Fn-30

P.Fn-31

You can specify the Personal Function settings listed below in the different tab sheets.
[Exposure Functions 1]

Disables the shooting modes (➞4-9)

Disables the metering modes (➞4-9)

[Exposure Functions 2]
Specifies the metering mode for manual exposure (➞4-10)

Sets the maximum and minimum shutter speeds to be used (➞4-10)

Sets the maximum and minimum apertures to be used (➞4-11)

[Exposure Functions 3]
Registers and switches the shooting mode and metering mode (➞4-11)

Repeats bracketing during continuous shooting (➞4-13)

Sets the number of shots to be bracketed (➞4-13)

Changes the bracketing sequence for C.Fn-09-2/3 to increased exposure, standard exposure, and decreased exposure ( ➞4-13)

Retains the shift amount for program shift (➞4-14)

[AF Functions]
Disables focus detection (search driving) by the lens drive (➞4-15)

Disables the AF-assist beam from being emitted (➞4-15)

Enables automatic shooting when focus is achieved at the fixed point of focus while the shutter button is pressed fully (➞4-16)

Disables automatic AF point selection (➞4-16)

Enables automatic AF point selection when C.Fn-11-2 has been set (➞4-17)

[Drive Functions]
Sets the continuous shooting speed (➞4-17)

Limits the number of shots during continuous shooting (➞4-17)

Enables quiet operation when the shutter button is OFF after picture-taking (➞4-18)

[Other Functions 1]
Changes the timer’s time length (➞4-18)

Illuminates the LCD panel during bulb exposures (➞4-19)

[Other Functions 2]
Sets the default settings when the CLEAR (QUALITY+WB) button is ON (➞4-19)

[Other Functions 3]
Enables the electronic dial’s function to be used in the reverse direction (➞4-19)

Prevents exposure compensation with the Quick Control Dial (➞4-20)

Enlargement mode (➞4-20)

Add original decision data (➞4-20)

[Combination]
Allows you to check the settings (➞4-21) Allows you to save the settings (➞4-22)
Allows you to load the saved settings (➞4-23)

* Omission of P.Fn-11, 12, 13, 22, 26 and 29
The numbers and descriptions for the Personal Functions contain some omissions due to the
fact that some functions on the EOS-1V and EOS-1D are omitted on the EOS-1Ds, but the
same Personal Function numbers are used on each model.
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3 Set up the Personal Function.
● Select the settings you want to set by clicking the checkboxes for the respective

items. Then use the appropriate method to specify the remaining settings using the
radio buttons, list boxes, checkboxes and number input boxes.

● If you enter a numerical value, values outside the valid range of settings are ignored.
● Clicking the [Load Settings] button replaces the settings with the Personal Function

settings on the camera.

4 Repeat steps 2 and 3 to set up additional Personal Functions.

5 Apply the Personal Function Settings to the camera.
● Clicking the [OK] button applies the

specified settings to the camera
and closes the [Personal Function
Settings] dialog box to end the
procedure.

● Clicking the [Apply] button applies
the specified settings to the camera
without closing the [Personal
Function Settings] dialog box.

\ When a Personal Function is
applied to the camera, <    >
appears on the LCD panel.

When you press the [Reset] button, the Personal Function Settings parameters are
reset as follows:
• The checkboxes are cleared.
• The radio buttons, list boxes and number input boxes revert to the default values.

Checkbox
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Personal Function Settings

P.Fn-01

P.Fn-02

Description of Personal Functions

Disables the shooting modes

● Click the checkbox of the shooting modes you do not want to use.
● Unwanted shooting modes can be skipped while you are selecting the shooting mode.
● This makes selecting the desired shooting mode faster.

At least one checkbox must be left unchecked.

Disables the metering modes

● Click the checkbox of the metering modes you do not want to use.
● Unwanted metering modes can be skipped while you are selecting the metering mode.
● This makes selecting the desired metering mode faster.

At least one checkbox must be left unchecked.
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P.Fn-04

P.Fn-03 Specifies the metering mode for manual exposure

● Click the radio button for the metering mode to be used during manual exposure.
● You can specify the metering mode to be used in the manual exposure mode.
● When you set the manual exposure mode, the metering mode selected here will be set

automatically. In the manual exposure mode, this enables you to use a metering mode
different from the one used in the AE modes.

Sets the maximum and minimum shutter speeds to be used

● Select the maximum and minimum shutter speeds from the list box.
● For example, if you set 1/2000 sec. as the fastest shutter speed and 1/60 sec. as the

slowest, the shutter speed range will be 1/2000 to 1/60 sec.
● This makes shutter speed selection faster and prevents a slow-speed sync. in aperture-

priority AE mode with the flash.

If you set the maximum and/or minimum shutter speed to one that is not a full-stop
increment (such as 1/750 sec.), the controllable and settable shutter speed range
might not be as exact as you set it. (A slight deviation may occur.) This applies if you
also set Custom Function C.Fn-6-1 and C.Fn-6-2 and set the maximum and/or
minimum shutter speed to one that is not a full-stop increment (such as 1/3200 sec.).

● To ensure that a proper flash sync speed is set in the Program AE mode, a shutter
speed range of 1/200 sec. to 1/80 sec. cannot be set.

● If safety shift has been enabled (with C.Fn-16), it will override P.Fn-04’s shutter
speed range when necessary.
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Personal Function Settings

P.Fn-05

P.Fn-06

Sets the maximum and minimum apertures to be used

● Select the maximum and minimum apertures from the list box.
● For example, if you set 1.4 for the largest aperture and 8.0 for the smallest aperture, the

usable aperture range will be f/1.4 to f/8.0.
● You can better control the apertures used by setting the range of usable apertures.

● Specify a minimum aperture value that is smaller than the maximum aperture
setting. If you select a minimum aperture value that is larger than the maximum
aperture, a warning message appears and the setting reverts to the default value.

● If you set the maximum and/or minimum aperture to one that is not a full-stop
increment (such as f/4.5), the controllable and settable aperture range might not be
as exact as you set it. (A slight deviation may occur.) This applies if you also set
Custom Function C.Fn-6-1 or C.Fn-6-2 and set the maximum and/or minimum
aperture to one that is not a full-stop increment (such as f/6.3).

● If the largest aperture of the attached lens is smaller than the largest aperture you
set with P.Fn-05, the largest aperture will be set to the largest aperture of the lens.
And if the smallest aperture of the attached lens is larger than the smallest aperture
you set with P.Fn-05, the smallest aperture will be set to the smallest aperture of
the lens.

● If safety shift has been enabled (with C.Fn-16), it will override P.Fn-05’s aperture
range when necessary.

Registers and switches the shooting mode and metering
mode

● While you press the <       > button, you can select the preset shooting mode, exposure
setting (such as the aperture for aperture-priority AE), metering mode, and exposure
compensation amount.

● Select settings that are appropriate for each shooting mode.
● The modes and settings are preset with the camera.

See “Registering the Modes and Settings with the Camera” for information on the camera
procedures. (➞4-12)

● Convenient when you want to instantly select the preset modes and settings to suit a
particular shooting situation such as backlit or front-lit conditions.
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P.Fn-06Registering the Modes and Settings with the Camera (               )

2 Register the modes and settings.
● First press the <      > button,

then press the <       > button.
\ <    > appears in the LCD panel,

indicating that the modes and
settings have registered.

● The registered modes and
settings can be modified any
number of times.

To register the modes and settings, first press the <      > button before the <       >
button. If you press the <       > button first, the camera will only select the
registered modes and settings instead.

● Depth-of-field AE and bulb cannot be preset.
● You cannot select the registered modes and settings during continuous shooting.
● If P.Fn-03 has been set to specify the metering mode for manual exposure, and

P.Fn-06 is used to register the manual exposure mode and a metering mode
different from the one specified with P.Fn-03, you can select the metering mode
specified with P.Fn-03 by pressing the <       > button.

● If P.Fn-04 and/or P.Fn-05 has been set, set the shutter speed and aperture
within the range specified with P.Fn-04 and/or P.Fn-05.

● If the shooting and metering modes you want to set are excluded by the
restrictions in P.Fn-01 and P.Fn-02, those Personal Functions must be disabled.
For information on clearing and resetting Personal Functions, see “Clearing and
Resetting Personal Functions” in the EOS-1Ds Instructions.

● Even if the shooting and metering modes selected by P.Fn-06 are excluded by
the restrictions in P.Fn-01 and P.Fn-02, they are still valid for P.Fn-06.

● If C.Fn-4-1 or C.Fn-4-3 has been set, AF and AE will also take effect when
you press the <       > button.

● When C.Fn-18 is set, P.Fn-06 is disabled.

1 Set the desired shooting mode and shooting mode settings
(aperture setting for aperture-priority AE mode). Then set the
metering mode and exposure compensation amount.
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Personal Function Settings

P.Fn-07

P.Fn-08

P.Fn-09

Repeats bracketing during continuous shooting

● While you hold down the shutter button, bracketing repeats continuously in the currently
selected drive mode.

● This function is useful when you want to continuously repeat the bracketing sequence.

Sets the number of shots to be bracketed

● Select the number of shots from the list box.
● The usual 3-frame bracketing is changed to 2-, 3-, 5-, or 7-frame bracketing.
● In bracketing shots, if you select 5-frame bracketing with 1-stop increment, the bracketing

for the shots is –2, –1, 0, +1 and +2.
● If you select 5-frame white balance bracketing, the frames are shot at –10, –5, 0, +5 and

+10 mireds.
● This function is useful for adjusting the range of bracketing.

● Even when the setting is outside the bracketing level display range, the exposure is
compensated as specified.

● This function can be used in combination with C.Fn-09-2/3 and P.Fn-09.

Changes the bracketing sequence for C.Fn-09-2/3 to increased
exposure, standard exposure, and decreased exposure

● The bracketing sequence when C.Fn-09-2/3 is selected (decreased exposure ➞ standard
exposure ➞ increased exposure) changes to increased exposure ➞ standard exposure
➞ decreased exposure.

● This function is useful when you want to start the bracketing sequence with a increased
exposed frame.

This function can be used in combination with P.Fn-08.
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P.Fn-10
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Darker         Brightness (EV at ISO100)         Brighter

Shutter Speed

Aperture

Standard program line
Program line shifted toward a faster shutter speed.
Program line shifted toward a slower shutter speed.

With EF 50mm f/1.4 USM lens

Retains the shift amount for program shift

● Normally, any program shift amount is canceled after you take the picture. This Personal
Function retains the program shift amount.

● This function is useful when you want to shift the standard program line so that priority is
given to the shutter speed or to the aperture.

By shifting the program, you can change the shutter speed or aperture and still retain the
same exposure level. Under the same brightness, you can shift the program line toward the
right to set a faster shutter speed and a larger aperture (lower f/number). Or you can shift the
program line toward the left to set a slower shutter speed and a smaller aperture (higher
f/number).
P.Fn-10 retains the amount of program shift. Select the appropriate amount of shift for the
level of priority you want to give to the shutter speed or aperture setting.

● The program shift amount remains in effect until you set it back to the standard
program manually or replace the battery or press the <          > button.

● The shift amount is retained even after you change the lens.
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P.Fn-14

P.Fn-15

Disables focus detection (search driving) by the lens drive

● Normally, when you press the shutter button halfway and focus cannot be achieved, the
lens is driven to search the correct focus. This lens driving operation can be turned off.

● When focus has been achieved once and refocusing fails, the subsequent lens driving
operation can result in grossly inaccurate focus. This subsequent lens driving operation is
turned off. P.Fn-14 is especially suited for super telephoto lenses.

If autofocusing is attempted while the lens is way out of focus, the lens may stop
operating. Focus manually until the subject outline becomes discernable, then
autofocus.

Disables the AF-assist beam from being emitted

● This disables the external Speedlite’s built-in AF-assist beam.
● At a joint photo session, etc., this prevents the AF-assist beam’s pattern projected on the

subject from being photographed by other photographers.
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P.Fn-16

P.Fn-17

Enables automatic shooting when focus is achieved at the
fixed point of focus while the shutter button is pressed fully

● This takes the picture automatically when the subject comes to the preset focusing
distance. Focusing detection is performed using the selected AF point.

● Set the lens focus mode switch to MF (or M) and focus manually at the desired point of focus.
● Keep pressing the shutter button fully.
● Using an accessory like Remote Controller RS-80N3 which can lock the shutter button

relieves you from holding down the shutter button while you wait for the subject.

● Because the camera remains on standby while the shutter button is fully pressed,
battery power is used up more quickly. For long periods of photography, use the DC
Coupler Kit.

● When this function is used in combination with a flash, the flash remains on standby
at full charge. Consequently, the flash batteries are used up more quickly. (The
Speedlite’s SE mode is disabled.)

● When you use a flash with this function, set the drive mode to single-frame
shooting. If you select continuous shooting, the flash will be unable to charge in
time for successive shots and will not fire at full charge.

● If you set the drive mode to continuous shooting, set the number of shots in
P.Fn-20. If you do not use P.Fn-20, once the camera focuses on the subject,
continuous shooting will continue until the capacity of the CF card is reached.

● P.Fn-16 cannot be used with manual focus lenses or with lenses that are too slow
to be used with autofocusing.

● Do not use this function when C.Fn-4-1/3 is set as shots will be taken regardless of
whether the image is in focus.

Using an accessory like Remote Controller RS-80N3 which can lock the shutter button
is recommended.

Disables automatic AF point selection

● During manual AF point selection, if you try to select an AF point beyond a peripheral AF
point, the camera normally switches to automatic AF point selection. This Personal
Function prevents this.

● When you select beyond the peripheral AF point, the selection stops there. It makes
selecting a peripheral AF point faster.

● If C.Fn-11-2 has been set, you can switch to automatic AF point selection by
pressing the <       > button during autofocusing. (➞ “AF Point Selection” in the
EOS-1Ds Instructions)

● If automatic AF point selection has been preset at [AF frame registration] setting,
the preset setting remains valid. (➞ “AF Point Registration and Switching” in the
EOS-1Ds Instructions)
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Personal Function Settings

P.Fn-18

P.Fn-19

P.Fn-20

Enables automatic AF point selection when C.Fn-11-2 has
been set

● Enables the standard horizonal AF point selection together with automatic AF point
selection with C.Fn-11-2.

● Convenient when you want to use automatic AF point selection while C.Fn-11-2 has been
set.

If P.Fn-17 [Disables automatic AF point selection] has also been set, P.Fn-17 will
override P.Fn-18 to disable automatic AF point selection.

Sets the continuous shooting speed

● You can select the number of continuous shots during continuous shooting.
● By reducing the maximum continuous shooting speed, AI Servo AF continuous shooting

can be more stable.

In AI Servo AF, it may not be possible to complete the selected number of continuous
shots.

Limits the number of shots during continuous shooting

● This enables you to enter the maximum number of shots (1 to10) to be exposed during
continuous shooting while the shutter button is pressed fully.

● Convenient when you do not want to shoot an unwanted scene that follows.
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P.Fn-23

P.Fn-21 Enables quiet operation when the shutter button is OFF after
picture-taking

● When single-frame shooting is selected, this function selects quiet camera operation when
you release the shutter button from the fully pressed position to the half way position.

● This is useful when the camera operation noise would be disturbing after you take the picture.

If you select continuous shooting, the camera operates normally.

Setting mirror lockup with C.Fn-12 will further reduce the shooting noise.

Changes the timer’s time length

● After you press and release a button, the respective function remains active for a specific
number of seconds. You can change this number of seconds as necessary.

● The function’s activation time can be set from 0 to 3600 sec. (1 hour).
● If the standard activation time is too short or too long, you can adjust it.

6 sec. Timer

16 sec. Timer

Post-shutter
release timer

● After you press the shutter button halfway or the <    >
button.

● Depth-of-field AE setting time.

● FE lock time after you press the <       > button.

● Exposure setting retaining time after the picture is taken.
Setting this to a longer time can make it easier to shoot with
AE lock.

● LCD panel illumination time after the picture is taken.

Be aware that a longer activation time will consume more battery power. The battery
life will become shorter and fewer number of shots can be taken with the battery.

To turn off the function’s activation time midway, press the <            > button, <      >
button or <           > button.
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Personal Function Settings

P.Fn-24

P.Fn-25

P.Fn-27

Illuminates the LCD panel during bulb exposures

● After the bulb exposure starts, press the <LCD panel illumination> button to illuminate the
LCD panel until the bulb exposure ends.

● Convenient when you want to monitor the elapsed bulb exposure time.

Taking bulb shots for long periods speeds up battery charge depletion and reduces the
number of available shots.

Sets the default settings when the CLEAR (QUALITY+WB)
button is ON

● You can use this function to select the default mode selected when you press the
CLEAR button <QUALITY+WB>.

● Convenient when you want to instantly switch to frequently-used settings.

Enables the electronic dial’s function to be used in the
reverse direction

● The electronic dial’s rotational function can be reversed for selecting the AF point and
setting the shutter speed and aperture.

● By matching the dial’s rotation direction to the particular operation, the operation can feel
more intuitive.

When the <         > dial’s rotational function is reversed, the horizontal AF point
selection direction does not change.
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P.Fn-28

P.Fn-30

P.Fn-31

Prevents exposure compensation with the Quick Control Dial

● The Quick Control Dial cannot be used to set exposure compensation.
● This prevents exposure compensation from being set accidentally while the AF point is

being selected.

Enlargement mode

● Select which part of an image is enlarged.
● If you take the shot on the camera with this function [ON], you can enlarge an image.
● For more information on using this function on the camera, see “P.Fn-30 Enlarging the

image” in the EOS-1Ds Instructions.

● If you wish to enlarge an image, set P.Fn-30 to [ON] during shooting and playback.
Especially the image shot on the camera without setting P.Fn-30 to [ON] cannot be
enlarged.

● The image shot on any camera other than the EOS-1Ds cannot be enlarged.

Add original decision data

● The data that shows whether or not the image is the original one can be added to the
image.

● For the decision of the original image, you will need the special accessory (optional).

● The original decision data is added to the image that has been shot using
RemoteCapture and saved in the CF card in the camera, but it is not added to the
image that has been transferred into the computer. (➞5-9)

● The original decision data cannot be added to the JPEG or TIFF image converted
from the RAW image.

If you take the shot on the camera with this function [ON], it takes time to write on the
CF card and the file size is increased to approx. 350 KB.
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Checking, Saving, and Loading Personal Function Settings
Use the procedure below to check the details of the Personal Functions that have been set up.
You can also save the settings on your computer and then load the saved settings and apply
them to the camera.

Checking the Settings

1 Select the [Combination] tab.
\ The [Combination] tab sheet is displayed.
● You can use this tab sheet to check the Personal Function parameters currently set

on your computer and check whether they have been applied to the camera.

2 If the data has not been applied, click either the [OK] button or
the [Apply] button as required.
● Clicking the [OK] button applies the specified settings to the camera and closes the

[Personal Function Settings] dialog box to end the procedure.
● Clicking the [Apply] button applies the specified settings to the camera without

closing the [Personal Function Settings] dialog box.

Clicking the [Load Settings] button replaces the settings with the Personal Function
settings on the camera.
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Saving the Settings

Click the [Save As] button or [Save] button.
\ The specified Personal Function

settings are saved.

\ When you click the [Save As] button, the [Save As] dialog box appears.
● Enter the file name and select the destination folder. Then click the [Save] button.
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Personal Function Settings

Loading Saved Settings

1 Open the saved settings.
● Click the [Open] button.
\ The [Open] dialog box appears.

2 Load the settings.
● Open the folder containing the settings, select the file and click the [Open] button.

\ The Personal Function settings data saved in that file are loaded into the computer.

Windows/Macintosh compatibility for Personal Function settings data
Personal Function settings data saved on your computer is compatible between
Windows and Macintosh.
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Setting the Parameters
You can set the parameters for captured images on the camera. You can register up to 3
parameters on the camera, consisting of the JPEG image quality settings, the sharpness
settings and the tone curve data saved during the procedure described in “Adjusting the Color
and Brightness (Adjust Tone Curve)” (➞3-22). For JPEG images, all the parameters are
applied. For RAW images, only the tone curve data and sharpness setting are applied.
For more information on setting the parameters on the camera, see “Setting the Processing
Parameters” in the EOS-1Ds Instructions.

Setting the Parameters

1 Click the [Parameters] button.
\ The [Parameters Settings] dialog box appears.

Selects the tone curve.
(➞4-27)

Registers the settings
on the camera.

Click this button to close the
[Parameters Settings] dialog box.

Opens the [User-Defined
Tone Curve] dialog box and
registers the user tone curve
on the camera. (➞4-25)

Sets the compression rate for
Normal JPEG image quality.
(➞4-27)

Sets the sharpness object.
(➞4-27)

Opens the parameter
settings help window.

Sets the sharpness intensity.
(➞4-27)

Sets the compression rate for
Fine JPEG image quality.
(➞4-27)
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Setting the Parameters

2 Select a set to be specified in the camera.
● Select the tab sheet for a set to be

specified in the camera from the
[Set1] to [Set3] tab sheets.

3 Click the [User-Defined Tone Curve] button.
\ The [User-Defined Tone Curve]

dialog box appears.
● If you do not wish to specify the

user-defined tone curve in the
camera, proceed to step 9.

4 Click the [Open] button.
\ The [Open] dialog box appears.

5 Load the tone curve settings file.
● Open the folder containing the tone

curve settings files, select a file,
and click the [Open] button.

● Save the tone curve settings files
into your computer in advance. For
details, refer to “Adjusting the Color
and Brightness (Adjust Tone
Curve)” (➞3-22).



4-26

Setting the Parameters

\ The tone curve data is loaded into
the [User-Defined Tone Curve]
dialog box.

6 Check the tone curve.
● Select the tone curve colors to be

displayed from the [Color Channel]
list box and check the colors.

● You cannot adjust the tone curve at
this point. Use the procedure in
“Adjusting the Color and Brightness
(Adjust Tone Curve)” (➞3-22) to
adjust the tone curve.

7 Click the [Apply to Camera] button.
\ The tone curve to be registered into the camera is set and the [User-Defined Tone

Curve] dialog box closes.
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Setting the Parameters

8 Select the tone curve.
● Select [Standard] or [User Defined]

in the [Tone Curve] list box.

● When you select [Standard], the standard tone curve is set.
● When you select [User Defined], the tone curve that you have set in steps 3 through

7 is set.

9 Select the sharpness and JPEG image quality.
● The [Intensity] and [Object] settings are applied to both JPEG and RAW images. The

[Fine Quality] and [Normal Quality] JPEG image quality settings are applied to JPEG
images.

● The available [Intensity] settings are [0], [1], [2], [3], [4], and [5].
Higher values give higher levels of edge sharpening.

● The available [Object] settings are [Fine], [Medium-Fine],
[Standard], [Medium-Rough], and [Rough]. If you select
[Rough], the specified sharpness level is applied to subjects
with a rough image pattern. If you select [Fine], the specified
sharpness level is applied to subjects with a fine image pattern.

● In the [Fine Quality] setting, you can select a value of [6], [7],
[8], [9] or [10]. Higher values give a lower compression ratio
and higher image quality.

● In the [Normal Quality] setting, you can select a value of [1], [2],
[3], [4] or [5]. Higher values give a lower compression ratio and
higher image quality.
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Setting the Parameters

10Click the [Apply to Camera] button.
\ The [Confirm Settings] dialog box

appears.

11 Check the settings and click the [Apply to Camera] button.
\ The settings are registered on the

camera and the [Confirm Settings]
dialog box closes.

12 Click the [Close] button.
\ The [Parameters Settings] dialog box closes to end the procedure.
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Selecting the Personal White Balance

Displays the file names for the
loaded white balance data.

Displays the setting status for the PC numbers
registered on the camera along with their captions.

Opens the white balance
data file.

Deletes the white balance
data from the PC number
selected in the [Select
Personal White Balance] list.

Closes the [Personal
White Balance
Settings] dialog box.

Registers the white balance data
for the PC number selected in the
[Select Personal White Balance]
list on the camera.

Displays the caption
for the loaded white
balance data.

Up to 3 personal white balance settings, consisting of the white balance data saved in the
“Saving the White Balance” procedure (➞3-28), can be registered on the camera. The
registered personal white balance settings are displayed on the camera’s rear LCD panel as
<            > to <            > (personal custom white balance 1-3). Personal white balance settings
can be applied to both JPEG images and RAW images.
For more information on setting personal white balance settings on the camera, see “Selecting
Personal White Balance” in the EOS-1Ds Instructions.

Selecting the Personal White Balance

1 Click the [Personal White Balance] button.
\ The [Personal White Balance Settings] dialog box appears.

Opens the help window of
the [Personal White Balance
Settings] dialog box.
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Selecting the Personal White Balance

2 Select PC number.
● Select the PC number for the data to be registered from the [Select Personal White

Balance] list.

3 Click the [Browse] button.
\ The [Open] dialog box appears.

4 Load the white balance data.
● Open the folder containing the saved white balance data, select a file and click the

[Open] button.

\ The white balance data is loaded.
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Selecting the Personal White Balance

5 Click the [Apply to Camera] button.
\ The white balance data is registered on the camera.
● To register another personal white balance setting, repeat steps 2 to 5. You can

register up to 3 settings (PC1, PC2 and PC3).
● To delete a registered PC setting, select the PC number from the [Select Personal

White Balance] list and click the [Delete from Camera] button.

6 Click the [Close] button.
\ The [Personal White Balance Settings] dialog box closes to end the procedure.
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This chapter describes the operations using the RemoteCapture software,
such as remote shooting, timer shooting and interval timer shooting.

Operating the Camera from
Your Computer

5
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Starting RemoteCapture

1 Click the [Start] button and select [Programs] ([All Programs] on
Windows XP) s [Canon Utilities] s [RemoteCapture xx] s
[RemoteCapture].
● RemoteCapture version information is displayed in xx.
\ The [RemoteCapture] dialog box appears.

2 Click the [Connect] button.
\ The Save window and Shooting

window appear.

● To exit RemoteCapture, click the [Disconnect] button and select [Exit] from the [File]
menu.

● If you use RemoteCapture to take pictures while you are using the WIA Driver
Windows Explorer to display images on the camera, RemoteCapture may not
operate correctly.

● When you are using mirror lockup to take pictures, there is a delay of approximately
2 seconds after you click the RemoteCapture [Release] button before the picture is
actually taken.

Selecting [Camera Settings] from the [Camera] menu in the Shooting window allows
you to specify the camera settings. For information on how to specify the camera
settings, see Chapter 4 “Specifying Camera Settings from Your Computer”.
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Starting RemoteCapture

Histogram
Shows the distribution
of the brightness of an
image.

Image Information
Allows you to check
the image information
details.

Comments input box
Use this field to type in a comment for the image.

Thumbnail view
Displays thumbnail
images of the
shots taken.

Delete button
Deletes the image selected in thumbnail
view. Deleted images are completely
removed from your computer. Check
images carefully before deleting them.

View button
Displays the image
selected in thumbnail
view enlarged in a
separate window.

Disconnect button
Cuts the connection
to the camera.

Save window

Image display area
Displays the image selected in the thumbnail view.

The [RAW] symbol is
displayed for RAW images.
The [RAW+JPEG] symbol is
displayed for RAW+JPEG
images. No symbol is shown
for JPEG images.

* The window above is the one on which all the information is displayed. In the actual use,
only the information needed for each circumstance is displayed.
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Starting RemoteCapture

Shots to Go
Displays the number of frames that
can be saved on your computer or on
the CF card in the camera.

Release button
Takes a shot with the
camera. The image is
automatically saved on
your computer.
Even when you press the
shutter button on the
camera, the image is
saved on your computer.

Rotation list box
Rotates the image to be shot
90 degrees left or right.

Shooting window

Size/Quality list box
Allows you to select the recorded
quality of images.

    Detail setting button
Displays the Detailed Settings window below
the Shooting window allowing you to make
various settings. Click the button again to close
the Detailed Settings window.

* The window above is the one on which all the information is displayed. In the actual use,
only the information needed for each circumstance is displayed.
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Using RemoteCapture
You can control the camera from your computer and take single-frame shots, timer shots and
interval timer shots. The images are automatically saved on your computer.
Shots taken with RemoteCapture and saved on your computer can be displayed and image-
processed in File Viewer Utility in the same way as images shot with the camera.
Refer to the Help file for more information on using RemoteCapture.

Before you use RemoteCapture, be sure to confirm that the camera is ready for
shooting. If the camera is not ready for shooting (the lens is not attached, etc.),
you cannot perform the operation as shown below.

Taking Shots from Your Computer

1 Set the camera up ready to shoot.

2 Make various settings.
● For information on how to set the size, image quality and image rotation, refer to

“Shooting window” (➞5-4).
● See “Default Settings” (➞5-9) for information on how to save images.

3 Take a test shot.
● Click [ ] (the Detail setting button) in the Shooting window and select the [Angle

adjustment] tab in the displayed the Detailed Settings window, and then click the
[Test Shot] button.

\ The test-shot images are displayed in the test-shot image display area.

Test-shot image
display area

With the auto focus function, if the camera is not focused, you cannot take pictures.
If you cannot take pictures with the auto focus function, focus the camera manually
and then take a picture.



5-6

Using RemoteCapture

4 Click the [Release] button.
\The image is saved to your computer and displayed on the screen.

● To enlarge the image for checking, select the image and click the [View] button.
\ The image is displayed enlarged in a separate window.
● To delete the image, select the image and click the [Delete] button.
\ The image is deleted.

● To load an image rotated, select [90 degree Right] or [90 degree Left] in the
[Rotation] list box before clicking the [Release] button.

● To rotate a downloaded image, select the image and then select [Rotate saved
Image 90 degree Right] or [Rotate saved Image 90 degree Left] in the [Edit] menu.

Checking Shooting Settings
You can confirm the camera settings used when images are taken.

Click [ ] (the Detail setting button) in the Shooting window and
select the [Shooting Settings] tab.
\ The camera settings used when

images are taken are displayed.
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Using RemoteCapture

Interval Timer Shooting
This function allows you to specify the interval between shots and the number of shots.

1 Click [ ] (the Detail setting button) in the Shooting window and
select the [Interval Timer Shooting] tab.
\ The [Interval Timer Shooting] tab sheet in the Detailed Settings window appears.

2 Enter the shooting interval and the number of shots, and then
click the [Start] button.
● You can set a shooting interval

between 5 seconds and 60 minutes
in 1-second increments.

● You can set up to a maximum of
9999 shots.

\ Interval timer shooting is performed
using the specified interval
between shots and the specified
number of shots.

On some types of computer, if you set a short interval between shots and there is
insufficient time to download and save the images, it may not be possible to take shots
at the specified interval. If this occurs, set a longer interval between shots and take the
shots again.

Depending on the available capacity on your computer’s hard disk, the maximum
number of available shots that can be set may be less than 9999. You can check the
number of shots that can be set by referring to the number of available shots shown in
the Shooting window. (➞5-4)



5-8

Using RemoteCapture

Timer Shooting
Use this function to specify the timer delay. Timer shooting shots are then taken after the
specified number of seconds.

1 Click [ ] (the Detail setting button) in the Shooting window and
select the [Timer shooting] tab.
\ The [Timer shooting] tab sheet in the Detailed Settings window appears.

2 Enter a number of seconds and click the [Start] button.
● You can set a value between 2 and

30 seconds in 1-second
increments.

\ Timer shooting are taken after the
specified number of seconds.

Printing Images
You can print images. All the images shown in the thumbnail view are printed in index format.
The time of shooting and the file names are printed with the images.

1 Select [Print Index] in the [File] menu in the Save window.
\ The Printer Setup dialog box appears.

2 Select the printer to be used, specify the print settings and print
an image.
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Setting RemoteCapture

Preferences dialog box

This section describes how to make various settings for using RemoteCapture. In the settings,
you can specify Default Settings to save images on your computer, and you can also specify
Detailed Settings to make shooting settings from your computer remotely.

Default Settings
Use the procedure below to select the folder in which images will be saved and to specify the
file names.

1 Select [Preferences] in the [File] menu in the Save window.
\ The [Preferences] dialog box appears.

2 Select the save destination in which images will be saved.
● Click the [Computer only] or [Memory card first, then computer] radio button.

● [Computer only]
This option allows you to take shots when there is no CF card in the camera or when
the CF card is full.

● [Memory card first, then computer]
This option saves the images both on your computer and on the CF card in the
camera.
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Setting RemoteCapture

3 Enter the file name to be used when images are saved.

● If you enter [Capture] into [File Prefix] field, [5] into [Number of Digits], and [1] into
[Start], sequential file names will be assigned automatically beginning with
[Capture_00001.jpg] or [Capture_00001.tif].

● File names can include up to 16 characters.

4 Select the folder in which images will be saved.
● Select the drive and then the folder

to be used for saved images.
\ The path for the selected folder

appears in the [Folder to which
Images are Downloaded].

● To create a new folder in which to
save images, click the [New Folder]
button to create a new folder inside
the current folder.

5 Click the [OK] button.
\ The settings are saved and the [Preferences] dialog box closes to end the procedure.

You can set the Hotkey for shutter release by selecting the [Release Hotkey] tab.
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Setting RemoteCapture

Detailed Settings
You can make shooting settings, such as White Balance and Exposure Compensation, from
your computer remotely.

Before you make detailed settings, be sure to confirm that the camera is ready
for shooting. If the camera is not ready for shooting (the lens is not attached,
etc.), you cannot make some of the settings.

1 Display the Detailed Settings window.
● Click [ ] (the Detail setting button) in the Shooting window.

2 Click the [Shooting Settings] tab.
\ The [Shooting Settings] tab sheet appears.

3 Specify the desired settings.

1

2

4

5

3

8

6

7
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1 Allows you to specify White Balance.
2 Allows you to perform Exposure Compensation.

(Valid only when Program AE/Av priority/Tv priority is specified in the shooting mode.)
3 Allows you to specify Metering Mode.
4 Allows you to specify ISO Speed.
5 Allows you to specify Color Temperature.
6 Allows you to specify Parameters.
7 Allows you to specify Color Matrix.
8 Allows you to specify the shooting mode, Av (aperture setting), and Tv (shutter speed).

4 Close the Detailed Settings window.
● Click  [ ] (the Detail setting button) in the Shooting window.
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The TWAIN Driver is the driver software used for Windows 98 SE and
Windows 2000.
This chapter explains how to start the TWAIN Driver and how to display
JPEG images stored on a CF card in the camera.
You cannot display or process RAW images with the TWAIN driver. Use
File Viewer Utility described in Chapter 3 to display or process RAW
images.

Downloading Images with
the TWAIN Driver
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The TWAIN Driver is started from a TWAIN Driver-compatible application.
The descriptions given here use the bundled application, Adobe Photoshop 5.0 LE, as an
example.
If you are using TWAIN Driver-compatible application other than Photoshop 5.0 LE, refer to
the User’s Manuals provided with your software for information on setting up and using a
TWAIN devices.

You cannot display or process RAW images with the TWAIN driver. Use File Viewer
Utility described in Chapter 3 to display or process RAW images.

1 Connect the camera to your computer. (➞2-2)

2 Start Photoshop 5.0 LE.
● Click the [Start] button and select [Programs] s [Adobe] s [Photoshop 5.0 Limited

Edition] s [Adobe Photoshop 5.0 Limited Edition].
\ Photoshop 5.0 LE starts up.

3 Select the [File] menu s [Import] s [Select TWAIN_32 Source].
\ The [Select Source] dialog box

appears.

Starting the TWAIN Driver

4 Select [Canon EOS-1DS] and click the [Select] button.
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Starting the TWAIN Driver

5 Select the [File] menu s [Import] s [TWAIN_32].
\ The TWAIN Driver starts and the

TWAIN Driver main window
appears.

\ The JPEG image saved on the CF
card in the camera is displayed.

Menu bar
Displays the [File]
and [Help] menus.

Thumbnail

Image display
area

TWAIN Driver main window

● To close the TWAIN driver, select [Exit] from the [File] menu on the menu bar.

Steps 3 and 4 are not required for every operation. Only perform these steps the first
time you start the driver software following installation, or when you change the setting
to another TWAIN Driver.
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Transferring Images to Photoshop 5.0 LE
This section describes how to transfer images to the TWAIN-compatible application
(Photoshop etc.).

1 Select an image to be transferred.

2 Select [Transfer Images] from the [File] menu on the menu bar.

\ The image transferred to
Photoshop 5.0 LE is displayed.

You can also transfer images by double-clicking a displayed thumbnail image.



The WIA Driver is the driver software used for Windows Me and Windows
XP. This chapter describes how to download images with the WIA Driver.
A number of restrictions apply to the WIA Driver, including restrictions on
image deletion and protection. For more information, refer to: click the
[Start] button s [Programs] ([All Programs] on Windows XP) s [Canon
Utilities] s [EOS-1DS WIA Driver] s [WIA Driver Readme].

Downloading Images with
the WIA Driver

7
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Downloading Images
You can download images using a wizard, Explorer or the WIA TWAIN.

Downloading with the Scanner and Camera Wizard
Follow the Wizard’s on-screen messages to download images to the computer. Note that you
cannot download RAW images using the [Scanner and Camera Wizard]. To download RAW
images, use Windows Explorer. (See “Downloading with Windows Explorer” (➞7-3).)

1 Connect the camera to your computer. (➞2-2)
\ If you are using Windows Me, the [Scanner and Camera Wizard] dialog box appears.
\ If you are using Windows XP, the [EOS-1DS] dialog box appears. Select [Microsoft

Scanner and Camera Wizard], and then click the [OK] button. The [Scanner and
Camera Wizard] dialog box appears.

2 Click the [Next] button.
\ The image selection window in the [Scanner and Camera Wizard] dialog box

appears.

3 Select the image(s) you wish to download and click the [Next]
button.
● To select multiple images, press

and hold the <Ctrl> or <Shift> key
on the keyboard while clicking on
images. To select all the images,
click the [Select All] button.

\ The image save destination
window in the [Scanner and
Camera Wizard] dialog box
appears.

4 Specify a file name and save location and click the [Finish] button.
● The selected images will be downloaded to the specified folder. If you do not specify

a folder, they are saved by default to the [My Pictures] folder within the computer’s
[My Documents] folder.
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Downloading Images

Downloading with Windows Explorer
Images can be downloaded to the computer with Windows Explorer just as you would copy
any other file. RAW images can also be downloaded this way.

1 Connect the camera to your computer. (➞2-2)
\ If you are using Windows Me, the [Scanner and Camera Wizard] dialog box appears.
\ If you are using Windows XP, the [EOS-1DS] dialog box appears.

2 Click the [Cancel] button.

3 Start Windows Explorer and select [EOS-1DS].
● You can start Windows Explorer by

right-clicking the [Start] button and
selecting [Explorer] from the menu
that appears.

\ The camera’s images will be
displayed as thumbnails in the
Explorer window.

4 Save the images on your computer.
● Download by Specifying a Folder

When you select and right-click an image in Explorer and then select [Save] from the
menu that appears, the [Browse for Folder] dialog box appears. Click on the folder to
be used to save the images and click the [OK] button. The image files and their
thumbnails are then saved in the selected folder.

● Download by Dragging and Dropping
Select an image in the Explorer window, drag it to the target folder and drop it.
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Processing RAW Images with Windows Explorer
Use the procedure below to start File Viewer Utility from Windows Explorer and process RAW
images.

1 Select a RAW image.
● Select a RAW image displayed in Windows Explorer.

2 Right-click on the selected RAW image and select the [Convert]
from the menu that appears.
\ File Viewer Utility starts, and the

thumbnail-displayed RAW image
appears in the File Viewer Utility
main window.

If you use RemoteCapture to take pictures while you are using Windows Explorer to
display images on the camera, RemoteCapture may not operate correctly.

● If you start File Viewer Utility from Windows Explorer, the functions of File Viewer
Utility that you can use are limited. In addition to that [Tree View Area] is not
displayed, the functions such as the camera settings, image rotation, image
transfer, index saving, image erasing, information update, image protection, sound
playback, etc. cannot be used.

● When you select [Properties] from the [File] menu, and click the [Camera Settings]
button in the [Camera Settings] tab sheet in the displayed [EOS-1DS Properties]
dialog box, you can specify the camera settings on the displayed dialog box. See
Chapter 4, “Specifying Camera Settings from Your Computer” for information on
how to specify the camera settings.

3 Process the RAW image.
● See “Processing RAW Images”

(➞3-18) for information on how to
process RAW images.
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Downloading Images

Downloading with the WIA TWAIN
This section describes how to start the TWAIN Driver-compatible retouching software, select
images via the WIA TWAIN Driver and import them into your program. The description given
here use the bundled application, Adobe Photoshop 5.0 LE, as an example.

1 Connect the camera to your computer. (➞2-2)
\ If you are using Windows Me, the [Scanner and Camera Wizard] dialog box appears.
\ If you are using Windows XP, the [EOS-1DS] dialog box appears.

2 Click the [Cancel] button.

3 Start Photoshop.
● Click the [Start] button and select [Programs] ([All Programs] on Windows XP) s

[Adobe] s [Photoshop 5.0 Limited Edition] s [Adobe Photoshop 5.0 Limited Edition].

4 Select the [File] menu s [Import] s [Select TWAIN_32 Source].
\ The [Select Source] dialog box appears.

5 Select [WIA-EOS-1DS xx] and click the [Select] button.
● WIA Driver version information is displayed in xx.

6 Select the [File] menu s [Import] s [TWAIN_32].
\ The [Get Pictures from EOS-1DS] dialog box appears.
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7 Select the image(s) you wish to download and click the [Get
Picture] button.
\ The selected image(s) will be

downloaded to the program.

RAW images will not be displayed in the WIA TWAIN. Accordingly, RAW images
cannot be downloaded with this method. To download RAW images, use Windows
Explorer. (See “Downloading with Windows Explorer” (➞7-3).)

The methods for starting the application and displaying the dialog box differ depending
on your retouching software. Refer to the User’s Manual provided with your retouching
software for details.



This chapter explains how to use ZoomBrowser EX to perform a range of
operations from downloading the camera’s images to printing them.

Working with Images in
ZoomBrowser EX

8
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Starting ZoomBrowser EX

1 Connect the camera to your computer. (➞2-2)
\ If you are using Windows Me, the [Scanner and Camera Wizard] dialog box appears.

Click the [Cancel] button to close the displayed dialog box, and then proceed to step 2.

2 Click the [Start] button and then select [Programs] ([All
Programs] on Windows XP) s [Canon Utilities] s [ZoomBrowser
EX] s [ZoomBrowser EX] to start ZoomBrowser EX.
● You can also start ZoomBrowser

EX by double-clicking the
[ZoomBrowser EX] icon on the
desktop.

\ The ZoomBrowser EX main
window appears.

3 Click [Camera & Memory Card] and [Browse & Download Images].

● This will display the Camera window.
\ The images on the CF card will display in the Camera window as thumbnails.
● If multiple PC card readers loaded with CF cards are connected or if a camera and a

PC card reader are connected, a selection dialog will appear before the Camera
window opens. Select one of the devices to proceed.

If you are using Windows XP, when you connect the camera to the computer, the
[EOS-1DS] dialog box appears. Selecting [Canon ZoomBrowser EX] and clicking the
[OK] button starts ZoomBrowser EX and displays the image saved on the camera in
the Camera window. If you have already connected the camera to the computer or you
wish to display the image from the card reader, follow the procedure above to start
ZoomBrowser EX.
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The ZoomBrowser EX Window
When you start ZoomBrowser EX, the ZoomBrowser EX main window appears. Then, when
the connection to the camera opens, the Camera window appears.

For more information on using ZoomBrowser EX, refer to the ZoomBrowser EX Help
menu or PDF manual, ZoomBrowser EX Software User Guide.

Main Window
ZoomBrowser EX’s main window features various buttons and an image display area. This
section introduces the names and functions of the various window parts.

Folders Area
Select image folders here. As in
Windows Explorer, you can view
the contents of the folders. Function Buttons

Browser Area
Displays the images contained in the
folder selected in the Folders area.
Double-clicking an image shows it at a
larger size.

Task Buttons
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The ZoomBrowser EX Window

Task Buttons
Select a procedure you wish to carry out from those below. When you click a button, an
additional menu of functions will display.

● [Camera & Memory Card] Button
Use this to display the Camera window. Clicking this button opens the menu with options
such as [Browse and Download Images], [Upload Images], [My Camera Settings] and
[Remote Shooting].

● [Print] Button
Use this to print an image. Clicking this button opens the menu with options such as [Layout
Print] and [Index Print].

● [View & Modify] Button
Use this to view or edit images. Clicking this button opens the menu with options such as
[View as a Slide Show], [Process RAW Images], [Edit Image] and [Stitch Photos].

● [Internet] Button
Use this button to attach an image to an e-mail message. Clicking this button opens the
menu with the [Email Images] option.

Function Buttons
The following functions can be performed on images selected in the Browser Area.

● [View Mode] Button
Switches between the Zoom Mode and Scroll Mode to suit your requirements.

Zoom Mode
When a folder has been created within a folder, this mode can be used to display all the
images within the nestled folder. Selecting the magnifying glass (+ or –) then clicking within
a folder or on an image in the Browser Area changes the size at which an image is
displayed or the folder level. You can also zoom up by double-clicking an empty part of the
Browser Area or the tab of a folder name.
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The ZoomBrowser EX Window

Scroll Mode
Displays the images in the selected folder only at a large, easy-to-view size. When there
are more images than can fit in the Browser Area, scroll bars appear at the right of the
Browser Area. When a folder has been created within a folder, it shows in the higher-level
folder as a folder icon only.

● [Thumbnail Size] Button (Scroll mode only)
Selects the size at which images are displayed in the Browser Area.

● [View Image] Button
Displays the selected image in the Viewer window.

● [Properties] Button
Displays information for the selected image as follows.

You can change the file name
or comment.

Switch between images with this button
when more than one image is selected.

If you select an image in the Browser Area while the Properties window is open, the
information in the window switches to the contents of the selected image.

● [Rotate] Button
Rotates selected images.

● [Delete] Button
Deletes selected images.
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The images from the camera
(or CF card) display here.

Task Buttons

Function Buttons

Camera Window
This section provides a brief introduction of the names and functions of the Camera window
parts.

Task Buttons
Select a procedure you wish to carry out from those below.

● [Download Image] Button
Downloads selected images to the computer.

● [Print] Button
Automatically starts the printing process after downloading the selected images to the
computer.

● [View as Slideshow] Button
Automatically starts a slide show after downloading the selected images to the computer.

● [Connect to Internet] Button
Automatically attaches the selected images to a mail message after downloading them to
the computer.
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The ZoomBrowser EX Window

Function Buttons
These buttons perform the following functions on the selected images.

● [Set] Button
Adjusts the settings for connecting to cameras.

● [Select] Button
Selects images.

● [Deselect] Button
Deselects images.

● [Rotate] Button
Rotates selected images.

● [Delete] Button
Deletes images from the camera.

● [Properties] Button
Displays the image information for the selected image.

● [Help] Button
Displays help topics.
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The ZoomBrowser EX Window

If the [Designate prefix of image to be
saved] option does not have a check mark,
the file name will be in the format [100-
0001.JPG]. If a check mark is placed here,
the file name is in the format
[name+0001.JPG].

Download Settings Window
The following window will display when you download images from the Camera window.

About Image Rotation During Downloading
The camera has a feature that rotates images shot with the camera on end to the correct
orientation when it is replayed. When you download JPEG images that have been rotated
automatically (if the [Auto Rotate] function is set to [On]) or manually by the camera, or that
have been rotated in the Camera window, two images are saved onto the computer, the pre-
rotation image and the post-rotation image. (This setting can be changed in the [Rotation] tab
in ZoomBrowser EX’s main window’s [Preference] option in the [Tool] menu.) RAW images,
however, are only downloaded with one image in the correct viewing orientation and the
rotation information is retained with the image.

Selects the folder to which transferred
images are saved.

To create a new folder within the folder
specified above, select [Create new folder]
and set a name for it.
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Thumbnail“RAW” displays on
RAW images.

Downloading and Saving Images from the Camera

1 Select the images you wish to download from the Camera
window and click [Download image].
● Click images to select them. You can select multiple images by clicking on

successive images. To deselect an image, click it again.

\ A Download Settings dialog allowing you to select the image destination folder will
display.

If you are downloading images previously selected with the camera’s [Transfer Order]
setting, click [Select] and select [Select Send Mark].

2 Make sure the settings are appropriate and click [OK].
● For details, see “Download Settings Window” (➞8-8).
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Downloading and Saving Images from the Camera

\ At this point the Camera window will close and the main window will open. The
downloaded images will appear in the main window.

Printing Images

1 Select the image(s) you wish to print.
● Click images to select them. You can select multiple images by clicking on

successive images. To deselect an image, click it again.

2 Click [Print] and select [Layout Print].

\ A dialog allowing you to select the type of information that will be printed with the
image will display.
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Downloading and Saving Images from the Camera

3 Place a check mark beside the items (Comment, File Name and
Date and Time options) that you wish included in the print and
click [Finish].

● Please note that you can attach a comment to an image by selecting an image in the
ZoomBrowser EX window, selecting [Properties] and typing a comment.

\ The PhotoRecord printing program will start and display the PhotoRecord Print
Modes dialog.

4 Select a print mode and click [Next].
● For the purposes of this example, please select [Artwork/Layout album].

When you select the [Artwork/Layout album] option, you can resize or reposition
images freely for printing. The other print modes allow you to do such things as tile the
images for printing or arrange them for printing on Canon perforated paper.
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Downloading and Saving Images from the Camera

5 In the next dialog, set the paper size and other settings and click
[Next].

6 In the last dialog, select [Automatic layout] and click [Finish].
\ The PhotoRecord window will display.

7 If you wish to change the layout, set the printing settings in the
PhotoRecord window.

8 Click the PhotoRecord [Print] button.
\ The Print dialog will display.

9 Click [Print] to start printing.

When you click the [Print] button after having selected images and select [Index Print]
from the displayed menu then perform the procedures in step 3 of page 8-11, the
Index Print Settings dialog will display. Set the desired thumbnail size and paper size,
then click [Print] to start printing the index.
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ZoomBrowser EX Features
This topic introduces additional, convenient ZoomBrowser EX features.

Adjusting Image Quality and Printing
(Exif 2.2 Compliant)

The PhotoRecord utility features functions that allow you to print images with image quality
adjustments and also supports the Exif 2.2 standard (or Exif Print). This function automatically
selects optimal image correction settings to produce better prints.

1 Right-click an image you wish to print and select [Clip/Correct
Photo].

2 Place a check mark beside [Exif Print] or [Auto Photo Perfect]
and click [Close].
\ The selected image will be

corrected.

Images shot with cameras complying with the Exif 2.2 standard incorporate shooting
settings information, such as the shooting conditions and scene mode, along with the
image data. The Exif Print adjustment protocol uses this information to correct the
image quality more accurately to reflect the shooting settings.
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ZoomBrowser EX Features

Processing RAW Images with ZoomBrowser EX
To process RAW images in ZoomBrowser EX, start File Viewer Utility.

1 Select a RAW image.
● Select a RAW image from the Browser Area of ZoomBrowser EX main window.

2 Click the [View & Modify] button and select [Process RAW
Images] in the displayed menu.
\ File Viewer Utility starts, and the thumbnail-displayed RAW image appears in the File

Viewer Utility main window.

If you start File Viewer Utility from ZoomBrowser EX, the functions of File Viewer Utility
that you can use are limited. In addition to that [Tree View Area] is not displayed, the
functions such as the camera settings, image rotation, image transfer, index saving,
image erasing, information update, image protection, sound playback, etc. cannot be
used.
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Merging Panoramic Images with PhotoStitch
You can merge a series of overlapping images into a single, seamless panorama image.

Select the JPEG images in the Browser Area, click [View &
Modify] s [StitchPhotos].
\ PhotoStitch starts up.
● Follow the instructions in the guidance window to merge the images.
● Please refer to the PhotoStitch Help menu for more details.

Follow the
instructions to
merge the images.

● You cannot open RAW images in PhotoStitch.
● Up to four images can be merged using PhotoStitch.
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This chapter provides a troubleshooting manual and describes the
software uninstallation procedures.

Troubleshooting and
Uninstallation
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Troubleshooting
When the “Could not complete installation correctly” or “Communication between the camera
and computer failed” message appears, check the items described below.

Driver installation failed.

● Have you installed the EOS-1Ds TWAIN Driver or EOS-1Ds WIA Driver?
➞ You cannot install the driver correctly unless the EOS-1Ds TWAIN Driver or EOS-1Ds

WIA Driver is already installed. Insert the SOLUTION DISK into the CD-ROM drive and
install the EOS-1Ds TWAIN Driver or EOS-1Ds WIA Driver.

● Is the cable firmly plugged into its socket?
➞ Ensure that the plug on the interface cable is securely plugged into the IEEE1394 port on

your computer. (➞2-2)

● Is your PC’s IEEE1394 device operating normally?
Open the [Device Manager] (➞9-5), click
the plus symbol [+] to the left of [1394
Bus Controller] and check that
[XXXXXXX] is displayed.

➞ If [XXXXXXX] is not displayed, plug &
play is not possible using the
IEEE1394 connection because the
IEEE1394 device is not operating
normally. Refer to the user manuals
supplied with your PC for information
on diagnosing and correcting the
problem.
([XXXXXXX] displays the name of your
IEEE1394 device.)
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Troubleshooting

I have installed the software but the camera and computer
cannot communicate.

● Is the driver installed?
➞ The driver is required for the communications between the camera and computer. When

you use the SOLUTION DISK software to communicate between the camera and
computer, be sure to install the driver shown below appropriate to your operating system.
• Windows 98 SE/Windows 2000: TWAIN Driver
• Windows Me/Windows XP: WIA Driver

● Does your computer comply with these requirements?
➞ The system has a built-in OHCI-compatible IEEE1394 port and it comes with Windows

98 Second Edition, Windows Me, Windows 2000 or Windows XP preinstalled. (Not
compatible with upgraded machines.)
* The IEEE1394 interface is not supported for systems not complying with the above

conditions.

● Are the camera and computer connected correctly?
➞ Connect the camera to your computer correctly using the interface cable. (➞2-2)

● Is there sufficient charge left in the camera battery?
➞ Your computer does not supply power to the camera. Connect the DC Coupler Kit to the

camera or load a fully charged battery into the camera before connecting it to your
computer. (➞ “Installing and Removing the Battery” in the EOS-1Ds Instructions.)

● Do you have more than one camera connected to your computer?
If you connect more than one camera to the same computer, the driver and camera may not
operate normally.

➞ Shut down the software and disconnect all the interface cables. Then reconnect just the
interface cable that connects the camera to your computer.

● Is the driver operating normally?
Open the [Device Manager] (➞9-5). Click
the plus symbol [+] to the left of [Imaging
devices] and check that [EOS-1DS] is
displayed.
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Troubleshooting

➞ If [EOS-1DS] does not appear, the driver is not operating normally. Briefly disconnect
and then reconnect the interface cable, ensuring that the connection is secure. If [EOS-
1DS] still does not appear, use the following procedure to re-install the driver.
1 Disconnect the interface cable and uninstall the driver. (➞9-7)
2 Re-install the driver. (➞1-2)
3 After installation ends, restart your computer.
4 Following the restart, connect the camera to your computer using the interface cable.

(➞2-2)
5 Finish driver installation. (➞1-5)

➞ When the [X], [!] or [?] symbol is displayed beside [EOS-1DS], part of the driver is
missing or corrupted. Use the following procedure to re-install the driver.
1 Delete [EOS-1DS] displayed in [Imaging devices].
2 Disconnect the interface cable and uninstall the driver. (➞9-7)
3 Re-install the driver. (➞1-2)
4 After installation ends, restart your computer.
5 Following the restart, connect the camera to your computer using the interface cable.

(➞2-2)
6 Finish driver installation. (➞1-5)

● Is the driver installed correctly?
Open [Device Manager] (➞9-5). Click the plus symbol [+] to the left of [Other devices] or
[Unknown devices] and check whether [EOS-1DS] or [Canon Digital Camera] is displayed.

➞ If [EOS-1DS] or [Canon Digital Camera] is displayed in [Other devices] or [Unknown
devices], the driver was not installed correctly.
Use the following procedure to re-install the driver.

1 Delete [EOS-1DS] or [Canon Digital Camera] displayed in [Other devices] or
[Unknown devices].

2 Disconnect the interface cable and uninstall the driver. (➞9-7)
3 Re-install the driver. (➞1-2)
4 After installation ends, restart your computer.
5 Following the restart, connect the camera to your computer using the interface cable.

(➞2-2)
6 Finish driver installation. (➞1-5)
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Troubleshooting

To Display the Device Manager

● Windows 98 SE and Windows Me
➞ Click the [Start] button and select [Settings] s [Control Panel]. Then double-click the

[System] icon to open the [System Properties] dialog box and select the [Device
Manager] tab.

● Windows 2000
➞ Click the [Start] button and select [Settings] s [Control Panel]. Then double-click the

[System] icon to open the [System Properties] dialog box, select the [Hardware] tab and
click the [Device Manager] button.

● Windows XP
➞ Click the [Start] button and select [Control Panel] s [Performance and Maintenance] s

[System]. Then select the [Hardware] tab and click the [Device Manager] button.
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Uninstallation Procedure
● Before beginning the software uninstallation, close any other software you are using and

disconnect the interface cable from your computer.

Uninstalling the Software
The following explanation uses the procedures for uninstalling File Viewer Utility as an
example for uninstalling other programs as well.
● For information on uninstalling the TWAIN Driver or WIA Driver, see “Uninstalling the

Driver”. (➞9-7)
● Windows 2000 or Windows XP Professional users should log on with [Administrator]

privileges.
● To prevent computer malfunctions, always restart your computer after you have uninstalled

the software. Re-installing the software without first restarting your computer is particularly
likely to result in computer malfunctions.

1 Click the [Start] button and select [Programs] ([All Programs] on
Windows XP) s [Canon Utilities] s [File Viewer Utility xx] s [File
Viewer Utility Uninstall].
● File Viewer Utility version information is displayed in xx.

2 Proceed with the uninstallation as directed by the on-screen
messages.
\ Software is uninstalled.

When uninstallation ends, restart your computer.
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Uninstallation Procedure

Uninstalling the Driver
To uninstall the driver, you must first uninstall the [EOS-1DS TWAIN Driver] or [EOS-1DS WIA
Driver], then remove [EOS-1DS] from the [Scanners and Cameras Properties] dialog box or
the [Scanners and Cameras] dialog box, and then delete the driver settings files.
● Windows 2000 or Windows XP Professional users should log on with [Administrator]

privileges.
● To prevent computer malfunctions, always restart your computer after you have uninstalled

the driver. Re-installing the driver without first restarting your computer is particularly likely
to result in computer malfunctions.

1 Uninstall [EOS-1DS TWAIN Driver] or [EOS-1DS WIA Driver].
● If you are using Windows 98 SE or Windows 2000, click the [Start] button and then

select [Programs] s [Canon Utilities] s [EOS-1DS TWAIN Driver] s [TWAIN Driver
Uninstall].

● If you are using Windows Me or Windows XP, click the [Start] button and then select
[Programs] ([All Programs] on Windows XP) s [Canon Utilities] s [EOS-1DS WIA
Driver] s [WIA Driver Uninstall].

2 Proceed with the uninstallation as directed by the on-screen
messages.
\ The driver is uninstalled.

3 Connect the camera to your computer.
● When the [Scanner and Camera Wizard] dialog box or the [EOS-1DS] dialog box

appears when you are using Windows Me or Windows XP, click the [Cancel] button
to close the displayed dialog box.

4 Click the [Start] button and then select [Settings] s [Control
Panel].
● Windows XP users should click the [Start] button and then click [Control Panel] s

[Printers and Other Hardware].

5 Double-click the [Scanners and Cameras] icon.
● Windows XP users should click the [Scanners and Cameras].
\ If you are using Windows 98 SE or Windows 2000, the [Scanners and Cameras

Properties] dialog box appears. If you are using Windows Me or Windows XP, the
[Scanners and Cameras] dialog box appears.
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Uninstallation Procedure

6 Remove [EOS-1DS].
● If you are using Windows 98 SE or

Windows 2000, select [EOS-1DS]
and click the [Remove] button.

● If you are using Windows Me or
Windows XP, select and right-click
[EOS-1DS] and then select [Delete]
from the menu that appears. When
the confirmation message appears,
click the [Yes] button.

● Once [EOS-1DS] is no longer
displayed in the [Scanners and
Cameras Properties] dialog box or
the [Scanners and Cameras] dialog
box, close the dialog box and
proceed as follows.

● If drivers for other devices such as scanners are already installed, those device
names are displayed.

● In Windows Me and Windows XP, the icons for the installed cameras and scanners
are displayed.

7 Open [Device Manager]. (➞9-5)

8 Delete [EOS-1DS] or [Canon Digital Camera].

For Windows 98 SE and Windows Me users:
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Uninstallation Procedure

● If [EOS-1DS] or [Canon Digital Camera] is displayed when you click the plus symbol
[+] to the left of [Imaging devices] or [Other devices], select [EOS-1DS] or [Canon
Digital Camera] and click the [Remove] button.

● When the confirmation message appears, click the [OK] button.
● Click the [OK] button to close the [System Properties] dialog box.
● If [EOS-1DS] or [Canon Digital Camera] is displayed in both [Imaging devices] and

[Other devices], or is displayed more than once in [Other devices], delete all the
occurrences.

● When [EOS-1DS] or [Canon Digital Camera] is not displayed in [Imaging devices] or
[Other devices], close the dialog box and proceed as follows.

For Windows 2000 and Windows XP users:

● If [EOS-1DS] or [Canon Digital Camera] is displayed when you click the plus symbol
[+] to the left of [Imaging devices] or [Other devices], select and right-click [EOS-1DS]
or [Canon Digital Camera] and select [Uninstall] from the menu that appears.

● When the confirmation message appears, click the [OK] button.
● Close [Device Manager], and click the [OK] button to close the [System Properties]

dialog box.
● If [EOS-1DS] or [Canon Digital Camera] is displayed in both [Imaging devices] and

[Other devices], or is displayed more than once in [Other devices], delete all the
occurrences.

● When [EOS-1DS] or [Canon Digital Camera] is not displayed in [Imaging devices] or
[Other devices], close the dialog box and proceed as follows.

9 Delete the driver settings files.
● The method for deleting the settings files differs depending on your operating system

software. Refer to the information on the following pages to delete the settings files.
• Windows 98 SE, Windows Me (➞9-10)
• Windows 2000 (➞9-12)
• Windows XP (➞9-14)



9-10

Uninstallation Procedure

Deleting the Driver Settings Files
Mistakenly deleting the wrong files can cause Windows to malfunction.
Check the file names carefully before deleting any files.

For Windows 98 SE and Windows Me users:

1 Click the [Start] button and select [Settings] s [Folder Options].
● Windows Me users should click the [Start] button and select [Settings] s [Control

Panel]. Then double-click the [Folder Options] icon.
\ The [Folder Options] dialog box appears.

2 Select the [View] tab.
\ The [View] tab sheet appears.

3 Select the [Show all files] radio button in [Hidden files].
● Windows Me users should select the [Show hidden files and folders] radio button in

[Hidden files and folders].
● If you have already selected this option, proceed without changing it.

4 Click the [OK] button to close the [Folder Options] dialog box.
\ Previously hidden folders and files now become visible.
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Uninstallation Procedure

5 In the [My Computer] window on the desktop, double-click [C:] s
the [Windows] folder s the [Inf] folder to open.

6 Delete [Drvdata.bin] and [Drvidx.bin].

7 Double-click the [Other] folder in the [Inf] folder to open.

8 Delete the [Canon.IncCAP_1DS.inf] file if it exists.

The [Inf] folder contains a large number of files. Deleting the wrong files could, at
worst, prevent Windows from starting up. When you delete files, check the file names
very carefully before proceeding.

● The [Canon.IncCAP_1DS.inf] file may not exist depending on your computer system.
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Uninstallation Procedure

5 Click the [OK] button to close the [Folder Options] dialog box.
\ Previously hidden folders and files now become visible.

For Windows 2000 users:

1 Click the [Start] button and select [Settings] s [Control Panel].

2 Double-click the [Folder Options] icon.
\ The [Folder Options] dialog box appears.

3 Select the [View] tab.
\ The [View] tab sheet appears.

4 Select the [Show hidden files and folders] radio button in [Hidden
files and folders].
● If you have already selected this

option, proceed without changing it.
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Uninstallation Procedure

6 In the [My Computer] window on the desktop, open [C:] s the
[WINNT] folder s the [inf] folder.

7 Search for files called [Oem*] or [Oem*.pnf].
● Substitute a number such as 0 or 1 for the asterisk (*). Also, because [Oem*] and

[Oem*.pnf] files come in pairs, substitute the same number for the asterisk in each
pair (e.g. Oem0 and Oem0.pnf).

● The [Inf] folder may contain multiple pairs of [Oem*] files.

8 Check the contents of the [Oem*] files.
● Double-click an [Oem*] file to display the file contents. Check that [; **** Canon

Camera Driver Setup File ****] appears on the first line.
● If there are multiple [Oem*] files, repeat this procedure.
● Once you have identified the target file or files, make a note of the file names.

9 Delete the [Oem*] and [Oem*.pnf] files you identified.

The [Inf] folder contains a large number of files. Deleting the wrong files could, at
worst, prevent Windows from starting up. When you delete files, check the file names
very carefully before proceeding.
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Uninstallation Procedure

For Windows XP users:

1 Click the [Start] button and select [Control Panel] s [Appearance
and Themes] s the [Folder Options] icon.
\ The [Folder Options] dialog box appears.

2 Select the [View] tab.
\ The [View] tab sheet appears.

3 Select the [Show hidden files and folders] radio button in [Hidden
files and folders].
● If you have already selected this

option, proceed without changing it.

4 Click the [OK] button to close the [Folder Options] dialog box.
\ Previously hidden folders and files now become visible.
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Uninstallation Procedure

5 Click the [Start] button and then [My Computer].

6 Double-click [C:] drive s the [WINDOWS] folder s the [Inf] folder
to open.

7 Search for files called [Oem*] or [Oem*.pnf].
● Substitute a number such as 0 or 1 for the asterisk (*). Also, because [Oem*] and

[Oem*.pnf] files come in pairs, substitute the same number for the asterisk in each
pair (e.g. Oem0 and Oem0.pnf).

● The [Inf] folder may contain multiple pairs of [Oem*] files.

8 Check the contents of the [Oem*] files.
● Double-click an [Oem*] file to display the file contents. Check that [; **** Canon

Camera Driver Setup File ****] appears on the first line.
● If there are multiple [Oem*] files, repeat this procedure.
● Once you have identified the target file or files, make a note of the file names.

9 Delete the [Oem*] and [Oem*.pnf] files you identified.

The [Inf] folder contains a large number of files. Deleting the wrong files could, at
worst, prevent Windows from starting up. When you delete files, check the file names
very carefully before proceeding.
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Uninstallation Procedure

Uninstalling Photoshop 5.0 LE
● Before beginning the software uninstallation, close any other programs you are using and

disconnect the interface cable from your computer.

Uninstall Photoshop 5.0 LE as follows.
● Click the [Start] button and select [Programs] ([All Programs] on Windows XP) s

[Adobe] s [Photoshop 5.0 Limited Edition] s [Uninstall Photoshop 5.0 Limited
Edition].

● Proceed with the uninstallation as directed by the on-screen messages.

When uninstallation ends, restart your computer.
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Adobe Systems Inc. technical support information is available in the PDF file format on the
supplied CD-ROM.

PDF File Location and Opening Instructions
Place the Adobe Photoshop LE CD-ROM in the drive and double-click the [My Computer] icon
on the Windows desktop, followed by the [Photosle] CD-ROM icon. The window will show
folders with language names. Double-click the appropriate language folder and the
[Support.pdf] file within it.

● To read PDF files, Adobe Acrobat Reader must already be installed on your computer. An
installer for this program is on the Adobe Photoshop LE CD-ROM within each language
folder in a folder labeled [Acroread].

Adobe Customer Support
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This Instructions booklet is current as of September 2002. For information on using the
camera with system accessories introduced after this date, contact your nearest Canon
Service Center.
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